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Introduction
Introduction

Welcome to Pacific Timesheet , the premier web timesheet. Pacific Timesheet  allows your
employees to track their time and attendance from a web browser, time clock or cell phone. 
Pacific Timesheet  is available as an online service, or can be hosted on your own server.
Click here for a list of supported browsers and platforms.

Note: This help document is context-sensitive. When you select a page in Pacific
Timesheet and click the Help link at the top of that page, the appropriate help topic will
load.

Click here for a PDF version of this documentation.

Related Topics

 Setup Quick Start
 System Requirements

-o-
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System Requirements
Browser Requirements

Pacific Timesheet is a web-based application and supports the following web browsers:

Supported Browsers

Apple Safari 2.0 or later

Microsoft Internet Explorer 5.5 or later

Mozilla Firefox 1.3 or later

Note: This application tries to minimize the use of popup windows as much as possible.
However, there are some areas of the application that by necessity require a popup
window. You therefore may need to unblock popups for this application under certain
circumstances.

Server Requirements

If you are hosting the software yourself, here are the server requirements:

Supported Hardware

Computer and processor PC or Macintosh with Intel Pentium 4-compatible 2 GHz
processor

Memory 1 GB of RAM

Disk space 250 MB of available hard disk space for the program files.
Additional space is needed to store timesheets and other
employee data (see below).

Supported Operating Systems

Microsoft Windows 2000, XP, Server 2003, Server 2008, Vista

Linux SUSE, RedHat or any other Linux distribution capable of
running Java 1.5 or later.

Apple Macintosh OS X, any version capable of running Java 1.5 or later.

Supported Databases

Microsoft SQL Server SQL Server 2000, 2005, 2008 with Mixed Mode
Authentication (Windows Authentication and SQL Server
Authentication) enabled.

MySQL Version 5.0.22 or later.

Oracle Oracle 9i or later.

In general, hard disk space is related to the number of timesheets written annually. A
timesheet typically requires about 150K of storage. Based on this value the following table
will help you determine the amount of hard disk usage you can expect annually:

Hard Disk Usage

Timesheets Per Year Hard Disk Allocation Per Year

500 75 MB

5,000 750 MB
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10,000 1.5 GB

20,000 3 GB

You can optionally integrate with access devices to record employee time and attendance.
The following devices are supported:

Manufacturer Model

ACTAtek
www.actatek.com

 PIN
 Smart Card
 Fingerprint
 Combination

-o-

 



p8

© 2000-2007, Pacific Timesheet

Setup Quick Start
Setup Quick Start

If you are an administrator setting up Pacific Timesheet for the first time you will want to
read this page to familiarize yourself with some basic concepts, and learn how to get
up-and-running quickly. Please note that you can always get detailed information for each
page of the application by clicking the context-sensitive Help link in the upper-right corner.

Step 1. Configure System Settings

The first steps you should take to set up your system are to configure the following global or
system-wide settings:

 Set the default time zone for your employees on the System > General page.
 Specify your work break down structure (WBS) on the System > Work Breakdown

Structure page. For example, one business might track time against customers, projects
and tasks. Another business might track time against clients and jobs.

 Configure timesheet periods appropriate for your payroll or other reporting cycles from
the System > Time Periods page.

Note that you can change the above settings at any time, but doing so after employees start
entering time might be disruptive. 

You may optionally want to do the following before rolling the system out to your
employees:

 Set your list of company holidays from the System > Holidays page.
 Change the wording or terminology used for some labels from the System > Terminology

page.
 Upload your company logo and make other branding changes from the System >

Branding page.
 Configure bill and pay rates from the System > Bill Rates and System > Pay Rates

pages.

Step 2. Configure Timesheet Templates

The System > Templates page is where you configure the data fields that are displayed on
timesheets. You can create any number of different timesheet templates for different needs.
Two sample timesheet templates are provided:

1. The "Attendance Timesheet" template is for attendance-oriented time entry, and
captures daily in/out times and pay codes (e.g. Regular Time, Over Time, etc.).

2. The "Project Timesheet" template is for project or job-oriented time entry, and captures
hours against customers, projects and tasks.

You can use and modify these templates, or create any number of new ones to suit your
needs. When adding employees (described below), you will specify the timesheet template
as part of their profile.

Step 3. Configure Employee Policies

Employee policies allow you to control a variety of timesheet options, such as rounding
rules, leave accruals and over time calculations. You should review the "Standard Policy"
settings on the System > Policies page, then make changes or create new policies as
desired. You can have any number of different employee policies, such as separate policies
for exempt and hourly employees. When adding employees (described below), you will

/timesheet/system/system-edit.do
/timesheet/system/taskoptions-edit.do
/timesheet/system/taskoptions-edit.do
/timesheet/system/timeperiod-list.do
/timesheet/calendar/holiday-list.do
/timesheet/system/terminology-edit.do
/timesheet/system/branding-edit.do
/timesheet/system/branding-edit.do
/timesheet/rate/rateoptions-show.do?type=Bill
/timesheet/rate/rateoptions-show.do?type=Pay
/timesheet/timesheet/template-list.do
/timesheet/policy/policy-list.do
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specify the policy as part of their profile.

Step 4. Configure Pay Codes

The System > Pay Codes page lists the available pay codes. Pay codes are customizable
values that you can use to track different types of work and leave hours. Work pay codes
can include regular time, over time, etc. Leave pay codes can include sick, vacation, etc. 

Work pay codes are often used for tracking overtime. With Pacific Timesheet you have two
choices about how overtime is handled: 

1. You can have your employees select whether their hours are regular time, overtime, etc.
on their timesheet via a pull down menu. To do this you add the Pay Code field to your
timesheet template(s). 

2. You can have overtime be computed automatically by enabling overtime rules for the
employee policy. If you do this you will generally want to remove the Pay Code field
from the timesheet template, as you don't want the employee to enter their overtime
values. You will still be able to report on overtime hours even if there is no Pay Code
field on the timesheet.

Leave pay codes, such as sick and vacation, can have an associated balance. Any hours an
employee enters on their timesheet for these pay codes will automatically have an
equivalent amount deducted from their balance. Rules for whether balances are allowed to
go negative, as well as automatic accruals, are configured by editing the balance rules on
the appropriate employee policies.

Step 5. Add Projects/Tasks

Depending upon your work breakdown structure, you may need to visit the Tasks page and
create lists of customers, projects, tasks, jobs, etc. 

Note that you can also import tasks, etc. in bulk from an external system via import files.
The Importing/Exporting help topic has more details.

Step 6. Add Employees

The Employees page is where you add and edit your list of employees. Make sure the
appropriate policy and timesheet template is selected for each employee. 

You will also want to select the appropriate permission level for each employee, for example
"Employee" or "Manager". Permission levels control what access to the timesheet system
the employee will have, as well as giving fine-grained control over some aspects of time
entry. You can modify the permissions from the System > Security page, as well as create
entirely new permission levels.

Note that you can also import employees in bulk from an external system via import files.
The Importing/Exporting help topic has more details.

Employee groups can be created from the Employees > Group page. Employee groups can
represent a variety of different logical entities, such as cost centers, permission groups and
construction crews.

Step 7. Miscellaneous

Here are a few other topics worth being aware of:

 A variety of reports are available, and can be customized for your requirements. Pacific
Timesheet allows you to publish your custom reports and make them available to any

/timesheet/paycode/paycode-list.do
/timesheet/task/task-list.do
/timesheet/user/user-list.do
/timesheet/system/security-show.do
/timesheet/user/group-list.do
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suitable permission level. For instance, you can make a customized billing report
available only to managers, or an hours summary report available to employees.

 You may want to modify the audit level if you have stringent auditing requirements,
such as DCAA. You can do this from the System > General page.

 Most objects can be customized to add additional data fields. For instance, you might
want to add an employee photograph to the employee object, or a location pick list to
the timesheet template. Choose the "Manage Custom Fields" menu option in the pop-up
options menu in the upper-right corner of most lists of objects. 

Please let us know if we can help you by contacting your sales representative or visiting our
support site at http://www.pacifictimesheet.com/. Thank you for using Pacific Timesheet!

-o-
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Home
Home

The Home page is where you manage your employee account and preferences. It also
provides a "dashboard" where you can quickly view your balances, leave requests, company
announcements and other information.

The Calendar shows recent and upcoming holidays and leave requests.

Related Topics

 Change Password
 My Account
 Preferences
 Leave Requests
 Holidays
 Announcements

-o-
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Change Password
Change Password

You can change your password at any time from this page. For security reasons you will
need to provide your old password.

Note: Passwords are case-sensitive, and can never be the same as your login name. There
may be other constraints, such as being a minimum number of characters in length,
depending upon how your application administrator has configured the password security
settings.

-o-
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My Account
My Account

The My Account page lets you view and change your employee profile. Your employee profile
has the following properties:

Property Description

Login Name Your login name, which can only be changed by an employee
manager or administrator.

First Name Your first name, up to 80 characters.

Last Name Your last name. This field is required and can be up to 80 characters.

ID Your employee ID, which can only be changed by an employee
manager or administrator.

Status Your account status, either Active, Inactive or Locked. Accounts can
become locked after too many unsuccessful login attempts. This can
only be changed by an employee manager or administrator.

Job Title Your job title, which can only be changed by an employee manager or
administrator.

Reporting Group Your primary or reporting group. This property may be renamed by
your application administrator to something more appropriate for your
organization, such as Division, Cost Center or Charge Code. This can
only be changed by an employee manager or administrator.

Email Your email address, up to 80 characters.

Phone Your phone number, up to 40 characters.

Mobile Your mobile phone number, up to 40 characters.

Fax Your fax number, up to 40 characters.

-o-
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Preferences
Preferences

The Preferences page lets you view and change your application preferences. This includes
the following properties:

Property Description

Timesheet Memory Allows you to specify whether rows and hours are carried forward
from the previous timesheet when a new timesheet is created.
Options include:
None New timesheets will have no rows or hours carried

forward from the previous time period.

Rows New timesheets will have the same rows as the
timesheet for the previous period, but all hours
fields will be blank. This is the default value for
employees.

Rows and Hours New timesheets will have the same rows and hours
as the timesheet for the previous period. Only work
hours are carried forward - leave (or paid time off)
rows will carry forward, but not the hours.

Note that you can hide this option from employees
by turning off the "Can copy previous timesheet
hours" timesheet permission for the employee's
permission level. See the Permission Levels topic
for more information.

Hours Format The choice of how you enter hours on your timesheet, either decimal
format (for example 3.5) or hours:minutes (for example 3:30).

Tab Direction The direction the selection moves when you type the tab key on your
timesheet, either vertical or horizontal.

Remember Last The number of most recently used clients, projects, etc. to remember
(25 max). To erase the list of most recently used items click the 
Clear List button.

Locale Your locale determines the following:
 The language displayed, e.g. English, French, Chinese, etc.
 The formatting of dates and numbers. If you choose a locale that

has AM/PM as part of its time format, you have the option of
overriding that by choosing the 24 hour time format (sometimes
called military time).

 The list of company holidays for the selected location

Time Zone Your time zone.

Search Results The number of rows to return per page of results, such as when
searching for employees, timesheets, etc.

Default Tab The tab to select upon logging into the application.

Export Format The file format for exporting timesheet data, employee lists, etc.
 CSV is a text format compatible with most systems (including

Microsoft Excel), and is the default value for employees.
 MS Excel is the Microsoft Excel format, a binary format generally

only compatible with Microsoft Excel. 

-o-
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Announcements
Announcements

Announcements are messages displayed to every employee who logs into the application.
You can use this feature to alert your employees of special events, such as maintenance
down time, or to company policies such as when timesheets are due.

Note: Text formatting is standard HTML. If your browser supports it, you will see a
WYSIWYG editor when editing the announcement text. You can click the "Source" button
on the editor tool bar to view and edit the HTML source. The maximum length of the HTML
is limited to 4000 characters (2000 characters if using Oracle for the database), and if you
exceed this amount the text will be truncated.

-o-
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My Timesheet
My Timesheet

The My Timesheet page is where you enter hours into your timesheet. By default you will be
taken to the timesheet for the current time period. You can change the time period by
clicking the Time Period link or clicking the next/previous buttons beside the Time Period
link. Time periods are determined by your application administrator, and usually correspond
to payroll or other company time periods.

A timesheet has a status, which can be Open, Submitted, Approved or Rejected. The
Open status means you can enter hours and make other edits to your timesheet. When you
have finished filling out your timesheet you should click the Submit button, which changes
your timesheet status to Submitted. Submitted timesheets cannot be edited.

Submitted timesheets can be reviewed and approved by an employee manager. If the
manager finds a problem with the timesheet they might reject it, which will revert the
timesheet back to its Open status, allowing you to correct any problem.

If your timesheet status is Open you can delete it and start over with a new one by clicking
the Delete button.

Timesheet Views

You can view your time entries using a Day View, Week View, Summary View or
Printable View. You can switch between views at any time, and changing your view will
save any changes you have made to your timesheet automatically. The Day View allows you
to view and enter time on a day-by-day basis. The Week View allows you to view and enter
time on a weekly basis (this view is not available if you are entering start times with your
time entries). The Summary View is a read-only view that lists all of the time entries for the
entire time period. The Printable View will generate a PDF version of the Summary View,
which is suitable for printing and signing by your manager.

Timesheet Rows

There are two types of time entries you can add to your timesheet: Work and Leave (note
that the terminology for these two types might have been changed by your application
administrator). Work time entries are added by clicking the Add Work button. Work time
entries generally require entering a Task or other description of the work done.

Leave time entries are added by clicking the Add Leave button. Leave time entries
generally require you select the type of leave, for example Vacation.

You can delete one or more rows at a time by checking the desired rows on your timesheet
and then clicking the Delete Row button.

If you are entering start times then rows will be ordered from earliest to latest. If you are
not entering start times then you can order the rows as you like by checking the desired
rows and then clicking the Move Up or Move Down buttons.

Choosing Tasks

Your timesheet may be configured for you to choose a Task, Project or other additional
properties for each time entry. The exact set of properties you need to choose will depend
on how your application administrator has set up the work breakdown structure (WBS) for
your organization. Choosing a Task, Project, etc. will pop up the Task browser, which allows
you to choose any level of the WBS.

You may narrow down the list of tasks shown in the browser by entering a query and
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clicking the Search button. You can refine your query using the '*' character. For instance,
to return all tasks starting with the letter 't' enter the query 't*'. To find all tasks ending
with the letter 't' enter '*t'. Searching for '*t*' is the same as just searching for 't' - it will
return any task with the letter 't' in it.

Timesheet Notes

The Notes field at the bottom of the timesheet allows you to enter notes or comments
about the timesheet. This is commonly used to inform your manager or approver about
anything special regarding your timesheet. The maximum size of a note is 4000 characters.

Other Timesheet Commands

There is a popup menu of additional Timesheet commands in the upper-right corner of the
timesheet. These commands include:

Copy Previous Timesheet will copy the rows and hours entered on the previous
timesheet. This command will only be available if the current timesheet has not been
submitted and has no hours, to avoid inadvertently overwriting your timesheet.

Copy Previous Rows will copy the rows (but not the hours) from the previous timesheet.
This command will only be available if the current timesheet has not been submitted and
has no hours, to avoid inadvertently overwriting your timesheet.

Copy Previous Day will copy the time entries for the previous day to the current day. This
command will only be available when in the Day View and if the current timesheet has not
been submitted and the day has no hours. If you choose this command for a Monday it will
move back to Friday to look for previous time entries if none are found on the weekend.

Delete Timesheet will delete the current timesheet. This command is only available if the
current timesheet has not been submitted.

-o-
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Leave Requests
Leave Requests

Leave requests facilitate the scheduling of employee time off. New leave requests are
submitted from the Home page by clicking the New Request link. Depending upon your
policy settings, your leave requests will automatically show up on your timesheet for the
requested days. Note that the term "Leave" may have been renamed by an administrator to
"Time Off" or some other terminology. The Terminology topic has more information.

Leave requests have the following properties:

Property Description

Request Type The type of leave request, for example 'Vacation'. The request type is
a pay code, and if you are a manager you can configure these from
the System > Pay Codes page.

Start Date The first day of the leave.

End Date The last day of the leave.

Partial Day If you are not taking a full day you can check this option to allow you
to enter the start time and finish time. Note that you may not see
this option if you are not allowed to take partial days of leave for the
selected request type. This is controlled by the Time Entry Rules
minimum/maximum leave hours setting - see the Time Entry Rules
topic for more information.

Requested Leave The number of leave days/hours to be taken. This will default to the
number of  days in the selected date range, excluding any weekend
days or holidays.

Description A description of this leave request, up to 255 characters. You might
use this to provide additional information to your approver, such as a
phone number where you can be reached in an emergency, etc.

Once you have submitted a leave request you can monitor its approval status from the
Home page. If your administrator has configured email notifications you will be sent an
email when a request is approved or rejected.

Approving Leave Requests

Leave requests require at least one approval level be enabled. You can configure approval
levels from the System > General > Approval Levels page - the Approval Levels topic has
more information. In addition, you need to be assigned as an approver to one or more
employees to be able to approve leave requests. The Managing Employees topic has more
information.

To list Leave Requests click the Leave Requests tab. By default you will see a list of all
future requests. You can narrow or refine the list using the search properties on the page.
To approve or reject leave requests simply click the appropriate checkbox in the list and
click the Save button. If notices are enabled the employees will automatically receive an
email indicating whether their request was approved or rejected. Clicking the Date hyperlink
in the list will show more details about the request. You can also approve or reject the
request from the details page.

To configure email notices for leave requests go to the System > Notices page. The Notices
topic has more information.
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Note: You can change the terminology for Leave to suit your organization's needs. The 
Terminology topic has more information.

-o-
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Managing Timesheets
Managing Timesheets

Employees can be given permission to manage other employee's timesheets. A timesheet
manager can view, edit and even delete timesheets, depending upon their permission level.
Any employee whose Permission Level allows timesheet management (for example
Administrator or Manager) can manage timesheets and will see the  Timesheets tab. If you
do not see the Timesheets tab then you have not been given a Permission Level with
timesheet management permissions. You can check an employee's Permission Level from
the Employees tab.

If the employee's permission level allows only limited timesheet management then the
employee will need to be added to the permission list for one or more employee groups.
This can be done by clicking the Groups link under the Employees tab, then clicking one of
the groups in the list. In the Permissions section for the group click the Edit button and
add the employee to the permission list with the appropriate permission level. The Groups
topic has more information.

Note: You can use timesheet management permissions to create "time keepers" -
employees with the ability to enter time for other employees. This avoids the need to log
in as another user in order to fill out their timesheet. If implementing time keepers it is
recommended that you create a new Permission Level with only the minimum required
timesheet permissions such as manage, edit and create. The Permission Levels topic has
more information.

Timesheet Lookup

To list employee timesheets click the Timesheets tab, enter an appropriate Start date,
then click the Search button. You can optionally enter a Finish date and Status in order to
narrow down the list of returned timesheets. 

If you do not find any timesheets then you may have only limited timesheet management
permissions. As mentioned above, you may need to be added to the permission list for one
or more employee groups.

Clicking a Time Period link in the list will load that employee's timesheet. Depending upon
your permission level, you may be able to edit or even delete this timesheet.

Exporting Timesheets

If your permission level allows it you can export the list of timesheets by clicking the popup
menu in the upper right of the list and then clicking the Export List link. This will export
the timesheet status information as displayed in the list to your local computer, in
comma-separated value (CSV) format. This file can then be opened in Microsoft Excel or
other applications that support the CSV format. You can optionally change this to Microsoft
Excel's native format (XLS) by clicking the Preferences link on the Home tab.

Clicking the Export Timesheet Data link will download the time entries for each timesheet
in the list as a file that you can save on your local computer. This is useful for exporting
time entries to external systems such as Payroll processing applications. You can optionally
mark time entries as being exported, so that you can avoid re-exporting the same data.
Once a timesheet has been marked as exported it cannot be unsubmitted (unlocked) for
re-editing. You will need to make corrections to the timesheet by clicking the "Add
Correction" button. This is a safeguard to avoid modifying previously exported time entries.
Note that administrators (those with the "Can Manage All" timesheet permission) can
bypass this restriction and still unsubmit a previously exported timesheet, if the need
arises.
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Another option for getting access to timesheet data is to run a Timesheet Details report.
This report can be customized to only output the fields you require, and can be downloaded
in a number of formats, including Microsoft Excel. The Reports topic has more information.

Importing Timesheets

If your permission level allows it you can import timesheet data by clicking the popup menu
in the upper right of the list and then clicking the Import Timesheet Data link. The
Importing/Exporting topic has more information.

Note: For security reasons you may only import timesheets if you are on the computer
running the timesheet service.

-o-
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Time Entry Corrections
Time Entry Corrections

Administrators and managers with the ability to edit timesheets may add corrective or
adjustment time entries to a timesheet that has been previously submitted or approved.
Once a timesheet has been submitted (locked) an "Add Correction" button will appear on
the timesheet. This allows you to make a change to the timesheet without unsubmitting it
first. This is necessary in instances where you only want to resend correction time entries
(either with negative or positive hours) to your payroll or billing systems.

To make a correction, locate the submitted or approved timesheet, switch to either the Day,
Week or Summary view, then click the "Add Correction" button. You will be presented with a
dialog in which you can enter properties for the corrective time entry, such as the pay code,
project, task and hours. If you want to make a change to an existing time entry, select the
time entry row before clicking the "Add Correction" button, and all of the fields will be
pre-filled. 

You can enter negative hours in a correction time entry in order to subtract hours from a
previous entry. For instance, in order to subtract 2 hours from a previous time entry, you
would select the previous time entry, click the "Add Correction" button, then enter -2 in the
hours field. When you click OK you will see the new negative time entry on the timesheet.

After adding correction time entries to a timesheet, any export flags for the timesheet will
be cleared. In this way you will be able to re-export the timesheet and send the correction
time entries to your payroll system. Adding a time entry correction to a timesheet will not
affect other time entries on that timesheet, making it easy to export only the corrections to
your payroll or billing systems.

-o-
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Approving Timesheets
Approving Timesheets

Submitted timesheets can be electronically signed by an employee's approver. An employee
can have a Primary Approver and a Backup Approver. Approvers are assigned to an
employee from the Employee Details page. Note that to be an approver the employee must
have a Permission Level such as Administrator or Manager with the "approve" timesheet
permission checked. If you do not see the Approval tab then your permission level does not
have the "approve" timesheet permission checked.

A backup approver has the same permissions as a primary approver, but will not be sent
any approval-related email notices. The Notices topic has more information.

Timesheet Lookup

To list employee timesheets click the Approval tab, enter an appropriate Start date, then
click the Search button. You can optionally enter a Finish date and Status in order to
narrow down the list of returned timesheets. If you do not find any timesheets no matter
what search criteria you use then you may not be assigned to any employees as an
approver.

Timesheet Approval/Rejection

Timesheets in the list that are submitted (pending approval) can be approved by checking
the checkbox in the Approved column. Then click the Save button to save the approval
change. 

You can approve individual time entries (line items) by clicking the Time Period link in the
timesheet list. This allows you to view the timesheet details and approve each row
individually. When all time entries are approved then the entire timesheet is considered
approved.

When viewing the individual time entries you have the option of rejecting any of them, and
thereby rejecting the timesheet. To reject a time entry check the Rejected checkbox for
the appropriate time entry, enter a Reject Reason at the bottom of the page, then click
the OK button to save the changes. A rejected timesheet is un-submitted and sent back to
the employee for correction.

Approval Options

You can customize which time entry fields are displayed in the timesheet details page by
clicking the popup menu in the upper-right corner and choosing Options. The Timesheet
Approval Options page lets you customize which timesheet fields are displayed in the
timesheet approval page. For a detailed description of the various timesheet fields refer to
the Templates topic.

Approval Levels

Your system can be configured to have mulitple approval levels (including zero levels, for
organizations that don't need timesheet approval). This is covered more fully in the 
Approval Levels topic.

Crew Time Approval

An alternative to approving timesheets is to use the Crew Time Approval page. This is more
appropriate for construction and field service applications where you are doing daily time
approval.
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Crew Time Approval
Crew Time Approval

The Crew Time Approval page allows you to review and approve time entries on a daily
basis. The Crew Time Approval page is accessed as a stand-alone (or kiosk) web page:

http://hostname/timesheet/kiosk/crew-approval.do

Where the "http://hostname" portion should be replaced with the appropriate value for
your Pacific Timesheet installation, for example "https://myco.pacifictimesheet.com".

Once you log into this page you will be able to view and approve/reject time entries on a
daily basis for employee groups. To be able to do this you must have the following
configuration:

 Your employee profile's permission level must allow you to approve. You can check your
permission level from the Employees page, and the permission level can be checked
from the System > Security page. You can be set to "Approve All" or "Approve Limited".

 If your approval permission is "Approve Limited" you must next be assigned to one or
more employee groups. For every group you are assigned to that you want to be able to
approve make sure the permission level is appropriate. For example, if your permission
level is "Manager" you must be assigned to one or more groups with the permission level
of "Manager".
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Managing Tasks
Managing Tasks

Normally time is recorded against a Work Breakdown Structure (WBS). A set of pre-defined
levels are provided: Project Groups, Projects, Task Groups and Tasks. Each level can be
renamed as appropriate for your organization, for example Project Groups may be more
appropriately called Clients, or Task Groups called Phases or Cost Centers. Also, not all
levels need to be used and can be disabled. The Work Breakdown Structure topic has more
information.

Levels may or may not have a hierarchical relationship, for example a Project may belong to
a Client, whereas a Cost Center could be used across all Projects.

Related Topics

 Customers
 Project Groups
 Projects
 Task Groups
 Tasks
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Customers
Customers

Customers have the following properties:

Property Description

Name The customer name, up to 80 characters. A value is required and
must be unique for all customers.

Description A description for the customer, up to 255 characters.

ID The customer ID, up to 80 characters. This value is not required, but
if a value is entered it must be unique for all customers. This is
commonly used for synchronizing with external systems, such as
billing or accounting.

Status The customer status, either Active or Inactive. You cannot delete
customers that have been used on timesheets. Setting the status to
inactive will prevent any further use of the customer.

Notes Notes about this customer, up to 2000 characters.

Note: You can change the terminology for Task, Task Group, Project, Project Group and
Customer to suit your organization's needs. The Terminology topic has more information.

Permissions

Permissions allow you to restrict which customers employees can access on their
timesheets. Employees with a Permission Level that gives them only limited viewing
permission, for instance, will only be able to access customers for which they have been
added to the permission list.
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Project Groups
Project Groups

Project Groups have the following properties:

Property Description

Name The project group name, up to 80 characters. A value is required and
must be unique for all project groups.

Description A description for the project group, up to 255 characters.

ID The project group ID, up to 80 characters. This value is not required,
but if a value is entered it must be unique for all project groups. This
is commonly used for synchronizing with external systems, such as
billing or accounting.

Status The project group status, either Active or Inactive. You cannot delete
project groups that have been used on timesheets. Setting the status
to inactive will prevent any further use of the project group.

Notes Notes about this project group, up to 2000 characters.

Note: You can change the terminology for Task, Task Group, Project, Project Group and
Customer to suit your organization's needs. The Terminology topic has more information.

Permissions

Permissions allow you to restrict which project groups employees can access on their
timesheets. Employees with a Permission Level that gives them only limited viewing
permission, for instance, will only be able to access project groups for which they have been
added to the permission list.

-o-
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Projects
Projects

Projects have the following properties:

Property Description

Name The project name, up to 80 characters. A value is required and must
be unique for all projects.

Description A description for the project, up to 255 characters.

ID The project ID, up to 80 characters. This value is not required, but if
a value is entered it must be unique for all projects. This is commonly
used for synchronizing with external systems, such as billing or
accounting.

Status The project status, either Active or Inactive. You cannot delete
projects that have been used on timesheets. Setting the status to
inactive will prevent any further use of the project.

Planned Start Date The planned project start date.

Planned Finish Date The planned project finish or end date.

Planned Work The planned total number of days to complete this project.

Actual Start Date The actual project start date.

Actual Finish Date The actual project finish or end date.

Actual Work The actual total number of days spent on this project.

Notes Notes about this project, up to 2000 characters.

Note: You can change the terminology for Task, Task Group, Project, Project Group and
Customer to suit your organization's needs. The Terminology topic has more information.

Permissions

Permissions allow you to restrict which projects employees can access on their timesheets.
Employees with a Permission Level that gives them only limited viewing permission, for
instance, will only be able to access projects for which they have been added to the
permission list.
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Task Groups
Task Groups

Task Groups have the following properties:

Property Description

Name The task group name, up to 80 characters. A value is required and
must be unique for all task groups.

Description A description for the task group, up to 255 characters.

ID The task group ID, up to 80 characters. This value is not required,
but if a value is entered it must be unique for all task groups. This is
commonly used for synchronizing with external systems, such as
billing or accounting.

Status The task group status, either Active or Inactive. You cannot delete
task groups that have been used on timesheets. Setting the status to
inactive will prevent any further use of the task group.

Notes Notes about this task group, up to 2000 characters.

Note: You can change the terminology for Task, Task Group, Project, Project Group and
Customer to suit your organization's needs. The Terminology topic has more information.

Permissions

Permissions allow you to restrict which task groups employees can access on their
timesheets. Employees with a Permission Level that gives them only limited viewing
permission, for instance, will only be able to access task groups for which they have been
added to the permission list.
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Tasks
Tasks

Tasks have the following properties:

Property Description

Name The task name, up to 80 characters. A value is required and must be
unique for all tasks.

Description A description for the task, up to 255 characters.

ID The task ID, up to 80 characters. This value is not required, but if a
value is entered it must be unique for all tasks. This is commonly
used for synchronizing with external systems, such as billing or
accounting.

Status The task status, either Active or Inactive. You cannot delete tasks
that have been used on timesheets. Setting the status to inactive will
prevent any further use of the task.

Planned Start Date The planned task start date.

Planned Finish Date The planned task finish or end date.

Planned Work The planned total number of days to complete this task.

Actual Start Date The actual task start date. This property is only available if projects
are disabled (see the Work Breakdown Structure topic for more
information).

Actual Finish Date The actual task finish or end date. This property is only available if
projects are disabled (see the Work Breakdown Structure topic for
more information).

Actual Work The actual total number of days spent on this task. This property is
only available if projects are disabled (see the Work Breakdown
Structure topic for more information).

Billable Indicates whether this task is billable or not. Note that you can
change which type of object (Project, Task, etc.) has the billable flag.
The Rate Options topic has more information.

Notes Notes about this task, up to 2000 characters.

Note: You can change the terminology for Task, Task Group, Project, Project Group and
Customer to suit your organization's needs. The Terminology topic has more information.

Permissions

Permissions allow you to restrict which tasks employees can access on their timesheets.
Employees with a Permission Level that gives them only limited viewing permission, for
instance, will only be able to access tasks for which they have been added to the permission
list.
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Managing Employees
Employees

Employees have the following properties:

Property Description

Login Name The employee login name. This is required, and must be a unique
value up to 80 characters.

Password The employee password, up to 40 characters.

First Name The first name, up to 80 characters.

Last Name The last name. This field is required and can be up to 80 characters.

ID The employee ID, up to 80 characters. This value is not required, but
if a value is entered it must be unique for all employees.

Status The employee status, either Active, Inactive or Locked. Accounts can
become locked after too many unsuccessful login attempts.

Last Login The date and time of the employee's last successful login.

Permission Level The permission level determines the maximum set of permissions an
employee has for the application. The exact set of permissions may
depend upon which objects a user is assigned to, and the permission
level they have for that object. For example, an employee may be
given a default permission level of Manager, but will not be able to
manage a project unless they are assigned to it and given the role of
Manager for that project.

When editing an employee, the list of permission levels will be limited
to only active permission levels. This list will be further limited
depending upon the default permission level of the logged-in user. For
instance, an Administrator will see the full list of active permission
levels, whereas a Manager will not see the Administrator role as it is
considered to have a higher security level.

Employee Type The type of employee, for example Non-exempt or Exempt. The list of
employee types can be customized from the General page under the
System tab.

Policy The policy for this employee. Policies are sets of rules affecting time
entry, balances, overtime, etc. and are managed from the Policies
page under the System tab.

Job Title The job title, up to 80 characters.

Reporting Group The primary or reporting group for this user. This is useful if the
employee is a member of more than one group, and determines which
group is associated with the employee's time entries. This can be
considered the Division, Cost Center or Charge Code in some
organizations, and can be renamed from the Terminology page under
the System tab.

First Day The first day of employment. The employee will not be allowed to
enter time for dates prior to this date. This value can also affect
balance accruals that vary based on the years employed (see the 
Balance and Accrual Rules topic for more information).

Last Day The last day of employment. The employee will not be allowed to
enter time for dates after to this date.
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Scheduled Hours The number of hours the employee is scheduled to work each week
and each work day. 

The scheduled hours per week is important if using the Percent Time
Entry timesheet template option, as it uses this value to convert
percentages to hours. See the Templates topic for more information
on timesheet templates.

The  scheduled hours per day is used when putting holidays and leave
requests onto timesheets. If no value is specified, the Hours Per Day
property on the System > General page is used.

Scheduled Start The time of day the employee is scheduled to start work or "punch
in". This value is used to determine if an employee is late (see the 
Notices topic for information about sending late email notices), as well
as is the default start time when adding new rows to an attendance
timesheet.

Scheduled Finish The time of day the employee is scheduled to finish work or "punch
out".

Email The email address, up to 80 characters.

Phone The phone number, up to 40 characters.

Mobile The mobile phone number, up to 40 characters.

Fax The fax number, up to 40 characters.

Timesheet Template The timesheet template for this employee, or blank if the user doesn't
have a timesheet. Timesheet templates are managed from the 
Templates page under the System tab.

Timesheet Memory Allows you to specify whether rows and hours are carried forward
from the previous timesheet when a new timesheet is created.
Options include:
None New timesheets will have no rows or hours carried

forward from the previous time period.

Rows New timesheets will have the same rows as the
timesheet for the previous period, but all hours
fields will be blank. This is the default value for
employees.

Rows and Hours New timesheets will have the same rows and hours
as the timesheet for the previous period. Only work
hours are carried forward - leave (or paid time off)
rows will carry forward, but not the hours.

Note that you can hide this option from employees
by turning off the "Can copy previous timesheet
hours" timesheet permission for the employee's
permission level. See the Permission Levels topic
for more information.

Time Format The choice of how you enter time, either decimal format (for example
3.5) or hours:minutes (for example 3:30). Note that whether a 12 or
24 hour clock used is determined by the locale.

Locale The locale determines the following:
 The language displayed, e.g. English, French, Chinese, etc.
 The formatting of dates and numbers
 The list of company holidays for the selected location
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Time Zone The employee time zone.

Default Bill Rate The default bill rate. The rate can be specified as either a named rate
or a custom numeric value. Named rates are configured from the Rate
Options page. The current bill rate, if non-zero, is used when a
timesheet is saved to compute the bill amount for each time entry.

Default Pay Rate The default pay rate. The rate can be specified as either a named rate
or a custom numeric value. Named rates are configured from the Rate
Options page. The current pay rate, if non-zero, is used when a
timesheet is saved to compute the pay amount for each time entry.

Salary The annual salary for non-hourly employees. The salary, if non-zero,
is used to compute an effective pay rate when a timesheet is
submitted. You should therefore only specify a pay rate or a salary,
not both. If both are specified the pay rate is used and the salary
ignored.

Note that the effective pay rate is based on the total hours for the
timesheet period. Since the total hours is only accurate when the
timesheet is submitted, the effective pay rate is not computed until
the timesheet is submitted. You can also have the effective pay rate
computed before a submit by specifying the 'Scheduled Hours'
property. Then, when a timesheet is saved (but not submitted) the
scheduled hours will be used instead of the total hours on the
timesheet to give an approximate effective pay rate. Once the
timesheet is submitted, however, the total hours will be used to give
an accurate effective pay rate.

Approver This is the primary timesheet approver for the employee.

Approver Backup This is the backup approver for this employee.

Notes Notes about this employee, up to 2000 characters.

Current Balances

The list of current balances for this employee are displayed. You can edit employee balances
by clicking the current balance link. The Employee Balances topic has more information.
Note that employee balances cannot be edited unless your Permission Level has the "edit
advanced" permission checked.

Group Membership

The list of groups this employee is a member of. The Employee Groups topic has more
information about managing groups.

Related Topics

 Employee Balances
 Employee Groups
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Employee Balances
Employee Balances

Employee balances are banks of hours that employees can accrue and use on their
timesheets, such as Vacation or Flex-time. Balances are associated with leave pay codes.
The Pay Codes topic has more information.

You can update an employee's balance from the Employee Details page. The Employee
Details page will list the current balance for each enabled balance. Clicking on the current
balance link will load the Balance History page. This page lists all changes made to the
balance, as well as allow you to add, deduct or set the balance as of a certain date.

Note: For security purposes, you can delete balance changes that you make but not ones
made by others.

If you need to update balances for a number of employees you can import the list of
changes using an import file. The Managing Employees topic has more information.

-o-

 



p37

© 2000-2007, Pacific Timesheet

Employee Groups
Employee Groups

Employee Groups are lists of employees, and are useful for configuring application
permissions.

Groups have the following properties:

Property Description

Name The group name, up to 80 characters. A value is required and must
be unique for all groups.

Description A description for the group, up to 255 characters.

ID The group ID, up to 80 characters. This value is not required, but if a
value is entered it must be unique for all groups.

Status The template status, either Active or Inactive.

Notes Notes about this group, up to 2000 characters.
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Reports
Reports

Pacific Timesheet supports over 50 different reports. Reports are customizable, allowing you
to:

 Alter which data columns are displayed
 Alter the names of the data columns
 Alter data sorting
 Alter data filtering
 Publish your customized reports for other employees to use

In addition, all reports can be output in HTML, PDF, CSV and Excel formats.

Timesheet Reports

Report Description

Employee Hours This report summarizes timesheet hours by employee. You can
expand this report to further group hours by:
 Pay Code
 Project
 Project Group
 Reporting Group
 Task
 Task Group

Note that when creating a new Employee Hours report you can
specify the special Employee Filter value "(Self)". When you add
"(Self)" to the Employee Filter only data for the currently
logged-in employee will be shown (any other employees in the
Employee Filter will be ignored). This is useful for allowing
employees to run reports on only their own time entries.

Pay Code Hours This report summarizes timesheet hours by pay code. You can
expand this report to further group hours by:
 Employee
 Project
 Project Group
 Reporting Group
 Task
 Task Group

Project Group Hours This report summarizes timesheet hours by project group. You
can expand this report to further group hours by:
 Employee
 Pay Code
 Project
 Reporting Group
 Task
 Task Group



p39

© 2000-2007, Pacific Timesheet

Project Hours This report summarizes timesheet hours by project. You can
expand this report to further group hours by:
 Employee
 Pay Code
 Project Group
 Reporting Group
 Task
 Task Group

Reporting Group Hours This report summarizes timesheet hours by reporting group.
You can expand this report to further group hours by:
 Employee
 Pay Code
 Project
 Project Group
 Task
 Task Group

Task Group Hours This report summarizes timesheet hours by employee. You can
expand this report to further group hours by:
 Employee
 Pay Code
 Project
 Project Group
 Reporting Group
 Task

Task Hours This report summarizes timesheet hours by employee. You can
expand this report to further group hours by:
 Employee
 Pay Code
 Project
 Project Group
 Reporting Group
 Task Group

Timesheet Details This report lists time entry details for a given date range. As
there are many time entry fields available to report on, you will
probably want to generate a custom version of this report to
show only the information you are interested in.

Note that when creating a new Timesheet Details report you
can specify the special Employee Filter value "(Self)". When you
add "(Self)" to the Employee Filter only data for the currently
logged-in employee will be shown (any other employees in the
Employee Filter will be ignored). This is useful for allowing
employees to run reports on only their own time entries.

Employee Reports

Report Description

Employee Attendance This report lists employees and the time they punched in.

Employee Details This report lists employee details, such as email, phone
numbers, etc.
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System Reports

Report Description

Audit Trail This report lists audit events for the given date range.

Logins This report lists employee logins (successful and unsuccessful)
for the given date range.

Report Properties

When creating or editing reports you can set the following properties:

Property Description

Name The report name or title, up to 80 characters.

Description A description for the report, up to 255 characters.

Template A read-only property that indicates which report was used as
the template for creating this report.

Published If checked then this report can be run by other employees. You
can limit which employees can access a published report by
clicking the button to the right of the check box and selecting
the appropriate permission levels.

Publishing a report does not allow others to edit it - only the
employee who created the report can subsequently edit it.

Page Size The page size for the report. Reports are designed for easy and
accurate printing, and this setting will determine how reports
are paginated.

Orientation The page orientation for printing, either Portrait or Landscape.
For reports with many columns you will generally want to
specify Landscape orientation.

Reporting Period The default time period for the report. The reporting period can
be overridden when running the report.

Report Columns The list of data columns to display on the report. In addition to
being able to add or remove any columns you like, you can also
edit the column heading.

Sort Columns The list of data columns to use for sorting. You can have
multiple sort columns, and sorting can be ascending or
descending.

Employee Filter If non-empty then the report will only show data for the
Employees in the list. You can override this value when running
the report.

The special filter value "(Self)" will limit the data to the
currently logged-in employee. This is useful for allowing
employees to run reports on only their own time entries. When
"(Self)" is in the list all other values in the list are ignored, and
you will not be able to override the filter when running the
report.

Reporting Group Filter If non-empty then the report will only show data for the Groups
in the list. You can override this value when running the report.
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Pay Code Filter If non-empty then the report will only show data for the Pay
Codes in the list. You can override this value when running the
report.

Project Group Filter If non-empty then the report will only show data for the Project
Groups in the list. You can override this value when running the
report.

Project Filter If non-empty then the report will only show data for the
Projects in the list. You can override this value when running
the report.

Task Group Filter If non-empty then the report will only show data for the Task
Groups in the list. You can override this value when running the
report.

Task Filter If non-empty then the report will only show data for the Tasks
in the list. You can override this value when running the report.
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Advanced Topics
Advanced Topics

Administration covers more advanced configuration settings, such as security settings and
customization.

Related Topics

 System Settings
 Pay Codes
 Templates
 Policies
 Security
 Notices
 Devices
 Schema
 Custom Fields
 Importing/Exporting
 REST API
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Administrative Overview
Administrative Overview

If you are setting up your timesheet system for the first time, the following settings should
be configured first:

 Week Start
 Default Time Zone
 Email Reply Address

These can be set on the System Settings page. These can be changed at any time, but it is
a best-practice to define these before you start creating new employees.
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System Settings
System Settings

The System page allows you to control application-wide settings, and is only accessible by
employees with a permission level that allows them to edit system settings, such as
Administrator. The following properties can be set:

Property Description

Week Start The first day of the week, for instance Sunday or
Monday. Note that you can still have different time
periods with different week starts, but this value will be
the default value.

Hours Per Day The default number of work hours in a day. This value
is used when putting leave and holidays on timesheets.
In addition, this value is used when displaying how
many days of balance are available on the employee's
home page. Note that you can override this value for
each employee by setting the Scheduled Hours Per Day
property on the Employee page.

Default Locale The default locale for new employees. A locale is a
language/country combination that determines the
formatting of dates, currency and numbers. All
diagnostic and audit log information is formatted using
the default locale, too.

Default Time Zone The default time zone for new employees.

Base Currency Base currency for application. This is used when
displaying or prompting for currency amounts.

Outgoing Email (SMTP) Server The host name or IP address of your outgoing email
server. Specify a value here in order to enable the
application to send email notifications such as
timesheet events or forgotten password requests. 
Self-hosted version only.

Login Name The optional login name for the outgoing email server. 
Self-hosted version only.

Password The optional password for the outgoing email server. 
Self-hosted version only.

Reply Address The email reply address for notifications sent by the
application. This is required if you have specified the
outgoing email server address.
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Audit Level The audit level controls the amount of auditing the
system performs. All audit events can be reported on
using the Audit Report, available from the Reports tab.
The following audit levels are provided:

Audit Levels

None No auditing

Standard Standard auditing, which includes
the following audit controls:
 Logging successful and

unsuccessful login attempts,
including their IP address

 Logging login name and
password changes

 Logging audit setting changes
 Logging user creation,

modification and deletion
 Logging timesheet deletion

High (DCAA) Full Defense Contract Audit Agency
(DCAA) auditing. This provides the
following additional audit controls
over the Standard audit level:
 Logging of any changes made to

an employee's timesheet by
another employee (for example
their manager).

 Logging of any changes an
employee makes to their own
timesheet if the time entry is
more than 24 hours in the past.

 Timesheets require approval
 Comments must be recorded

when timesheets are approved,
rejected, or resubmitted for
approval.

 For more information see http://
www.dcaa.mil/

Audit Days The number of days to keep audit data (maximum
365). Note that audit data, especially if using the high
(DCAA) level, can consume a considerable amount of
storage.

Application URL The base address for this application, for example
http://hostname/timesheet. This is used when
formatting links in email notices and other messages.
For instance, the notice variable ${System.url} will be
replaced with this value (see the Notices topic for more
details). Self-hosted version only.

Send Test Email

After configuring your email server settings it is a good idea to send a test email. The email
will be sent to the same address as the reply address.

Related Topics
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 Work Breakdown Structure
 Time Periods
 Holidays
 Approval Levels
 Rate Options
 Terminology
 Branding
 License
 System Lists
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Work Breakdown Structure
Work Breakdown Structure

The work breakdown structure (WBS) is used to organize work into a series of components,
such as projects, phases, tasks, etc. You can define up to 4 components, and name each
level as you need. For instance, your organization might have the following WBS:

Client > Project > Phase > Task

Or

Task > Labor Code

WBS components have the following properties:

Property Description

Enabled Indicates whether the component is enabled.

Dependent If checked then the component may depend on the previous
component. For example, if you have a two level WBS composed of
Projects and Tasks, checking the dependent check box for the Task
would indicate that the list of tasks presented to an employee might
depend on which project was selected. 

Name The singular name of the component.

Plural The plural name of the component.
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Time Periods
Time Periods

Time periods are used to define common timesheet and reporting periods. You can define as
many different time periods as you need. Once defined, they can be used when editing and
creating Timesheet Templates, or when running reports. The following types of time periods
are supported:

Type Description

Weekly 7 day time period, with your choice of the first day of the week.

Biweekly 14 day time period, with your choice of the first day of the week.

Semimonthly Semi-monthly time period, typically the 1st through the 15th, and the
16th through the end of the month.

Quadweekly 28 day time period, with your choice of the first day of the week.

Monthly Monthly time period, with your choice of the first day of the month.

Custom Custom time periods, where each time period can be a different
number of days.
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Holidays
Holidays

The Holidays page lets you define your company holidays. The following properties can be
set for each holiday:

Property Description

Name The name of the holiday, up to 80 characters. You should keep this as
short as reasonably possible, however, to better fit it on timesheets
and dashboards.

Description A description for the holiday, up to 255 characters.

Date The date of the holiday.

Repeat If this holiday recurs then select the appropriate value. For instance,
for New Years you could set the date to January 1, 2009 and choose a
repeat value of "Yearly on this date". For the U.S. holiday
Thanksgiving you could set the date to November 27, 2009 and
choose a repeat value of "Yearly on the 4th" Thursday of November.

Partial Day Check this option to create a partial day holiday. For instance, you
might have a half-day holiday on New Year's Eve. The actual number
of hours pushed onto employee timesheets will be determined by
their Scheduled Hours Per Day property on the Employees page
(or, if the employee property is not set, the Hours Per Day property
on the System > General page). For example, if the employee is
scheduled to work 8 hours per day, a half-day holiday would result in
4 hours being placed on the timesheet.

Locale You can limit the holiday to a specific set of locales or countries. If
this list is empty then there is no locale limitation. See the Managing
Employees topic for more information on employee locales.

Groups You can limit the holiday to a specific set of employee groups. If this
list is empty then there is no group limitation.
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Work Shifts
Work Shifts

The Work Shifts page lets you define your company work shifts. Work shifts affect how
much an employee is paid by applying a pay differential when working in certain shifts. The
following properties can be set for each shift:

Property Description

Name The name of the shift, up to 80 characters.

Description An optional description for the shift, up to 255 characters.

ID An optional unique identifier for the shift, up to 80 characters.

Start Time The start time for the shift, for example "8:00 AM".

Finish Time The finish time for the shift, for example "5:00 PM".

Valid Days The days of the week for which the shift is valid, such as Monday
through Friday.

Shift Differential The differential rate used to calculate a shift premium when
working in the shift, for example "0.25". If the employee's base
pay was $20/hour, the shift differential would result in a real pay
rate of $25/hour.

Once you have created your shifts you will still need to activate them per employee policy
from the System > Policies page. See the Wage Rules topic for more information.

Additional Configuration: Shift Over Time

If you need to track how much regular time, overtime and double time was spent in shifts,
you will need to do some additional configuration. You will need to create 3 custom
timesheet fields as follows (from the System > Templates > Custom Fields page):

Field Name Description

Shift Regular Time Type = Number, decimal digits = 2

Shift Over Time Type = Number, decimal digits = 2

Shift Double Time Type = Number, decimal digits = 2

The name of the custom field must be exactly the same as shown above. However, once you
have created the custom field, you can later rename it as desired without affecting the
system. Once you have defined these fields then any regular time, over time or double time
hours that fall in a shift will be placed into these fields.
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Approval Levels
Approval Levels

You can define multiple timesheet approval levels. Many organizations require additional
approval levels to handle different work flows. For instance you might have a manager
approval, a billing approval and a payroll approval. Creating separate approval levels can
facilitate any work flows that are triggered by the approval process.

Approvals are optional - you do not need to have any approval levels enabled if your
organization does not require timesheet approvals.

The following properties can be configured for each approval level:

Property Description

Enabled Indicates whether the approval level is enabled.

Name The name for the approval level, up to 40 characters. Names should
be as short as possible, and not include the word "level". If you only
have one approval level you do not need to specify the name.
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Rate Options
Bill/Pay Rate Options

Rate options allow you to control how bill and pay rates are specified when an employee
saves their time. Pacific Timesheet has a very flexible bill and pay rate engine that allows
you to configure your rates to depend on not just the employee or the project, but to have
rates that also depend on tasks, jobs and cost centers.

Note: Changes to rate options take effect for the current timesheet period and will not
affect previously submitted timesheets.

The following properties can be configured for bill and pay rates:

Property Description

Rates Depend On The type of object that rates primarily depend on, for example
Employees, or Projects.

Make Exceptions For The type of object for which you may need to make exceptions to
the primary rate. For instance, if your organization's bill rate
depends primarily on Projects, then you might make exceptions
for certain Employees.

Billable/Payable Flag On The object that has the billable/payable flag. A common example
is to have the billable flag on Tasks, so that certain tasks can be
marked as non-billable.

Rates Apply Only For The type of hours for which these rates are applicable. Bill rates
would generally only apply to work hours, whereas pay rates
might apply to both work and leave (in other words, paid leave).

Different organizations have different rules for how bill and pay rates are specified. For
instance, when keeping track of project bill rates you might configure bill rates as follows:

Rates Depend On: Projects
Make Exceptions For: Employees

Billable/Payable Flag On: Tasks
Rates Apply Only For: Work Hours

In the above example the default bill rate is set on the project. Employees can be given
specific bill rates on projects, overriding the default rate. Tasks have a billable flag, allowing
the creation of tasks that are non-billable. Time recorded against a non-billable task will
have a bill rate of zero, regardless of the project or employee bill rate.

Standard Rates

When specifying bill and pay rates you have the option of using named values, rather than
specifying an actual numeric rate. By assigning a named value to a set of employees, for
instance, you can later change the named value's rate and all of the employees will pick up
the new value. Rates have the following properties:

Property Description

Name The rate name, up to 80 characters. A value is required and
must be unique for all rates.

Rate The hourly rate, in the base currency. The base currency is
specified from the System Settings page.
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Status The rate status, either Active or Inactive. You cannot delete
rates that are currently assigned to employees. Setting the
rate to inactive will prevent the rate from being assigned to
new employees.
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Project Options
Project Options

The Project Options pages lets you configure global project settings, such as whether project
work is displayed as hours our days, the list of task states, etc. Note that the terminology of
projects, tasks and other objects can be changed via the System > General > Terminology
page.

The following properties can be configured:

Property Description

Default Work Units This setting determines whether planned and actual work is
entered/displayed in hours or days.

Task States This setting lets you control the list of task states, such as "In
Progress", "Completed", etc. as suits your organization's needs.
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Terminology
Terminology

You can override the default terminology for a number objects and phrases in the
application. Make sure when changing the terminology that you specify both singular and
plural versions to avoid confusion.

-o-
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Branding
Branding

Branding allows you to customize the application suit your organization. You can specify the
following properties:

Property Description

Company Name The name of your company or organization. The company name can
be used in email notices sent by the application.

Application Name The application name. The application name appears in several places
in the product, including the window title and email notices sent by
the application.

Application Logo The application logo, which appears in the upper-left corner of the
page. This is an image file, usually GIF or JPEG, and should be no
larger than 50 pixels tall and 350 pixels wide.

Clicking the Restore Defaults button will reset the properties to their factory settings -
make sure you click the OK button after clicking Restore Defaults to confirm the change.
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Data Integration
Data Integration

Data Integration allows you to enable and configure the external data and device integration
facilities provided by Pacific Timesheet. The following integration types are provided:

Integration Type Description

Timesheet Export Configure timesheet export settings, such as which time entry
fields are exported, etc. See the Timesheet Export Options topic
for more information.

Time Bank Time Bank software provides integration with most popular
payroll, HR and general ledger applications. Over 250 systems
are supported, and you can find out more by contacting your
sales representative or visiting our website at 
http://www.pacifictimesheet.com/.

QuickBooks Interchange
File (IIF)

QuickBooks IIF file support allows you to export your timesheets
into QuickBooks for both invoicing and payroll. See the 
QuickBooks Export File help topic for more information.

LDAP/Active Directory LDAP/Active Directory support allows you to use an LDAP or
Active Directory server for authentication, as opposed to the
built-in application authentication. For more information see the 
Security topic.

Time Clock Device Time clock device support allows you to integrate with external
time clock devices, such as those provided by ACTAtek. For more
information see the Devices topic.

Web Services API The web services API allows you to send and receive timesheet,
employee, project and other information with Pacific Timesheet.
For more information see the API topic.

Auto-Import Directory The auto-import directory allows you specify a folder that is
monitored for CSV files that will be automatically imported into
the system. See the Auto-Import Directory help topic for more
information.
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Timesheet Export Options
Timesheet Export Options

The Timesheet Export Options page allows you to configure how time sheet data is
exported. You can enable and define multiple export configurations, which is useful if you
need to export to more than one system, for example payroll and billing. The following
options are provided:

Options Description

Name You can name the export, which is useful if you have more than
one defined export. For example you might name one 'Payroll'
and the other 'Billing'. The name can be up to 80 characters in
length.

Description A description of the export configuration, up to 255 characters.

Enabled If checked then this export will show up in the list of available
exports in the Timesheets and Approvals tabs.

Clip to Date Range Check this option to clip time entries to the selected date range
when exporting. This option is useful if you are exporting time
entries for time periods different than the timesheet period. You
would want to check this option, for instance, if timesheets have
weekly periods but you export to payroll semimonthly.

Exported Fields Select the time entry data fields to export, as well as their order.
This option is useful if you need to integrate timesheet data with
external systems such as payroll processing, etc. For example, 
SurePayroll systems require the following 6 fields in this order:

TimeEntry.Date
Employee.ID
Employee.Last Name
Employee.First Name
Pay Code.ID
TimeEntry.Hours

Custom Header For some external systems you may want a special header at the
beginning of the export file, rather than the standard list of field
names. For example, SurePayroll systems require the following
two lines at the start of the file:

TC
00001

Rollup Check this option to roll up or total the hours in each time period
for each pay code. Instead of outputting an individual record for
each time entry, time entries will be summarized by pay code.

Timesheet Export Schedule

You can automate timesheet exporting using the timesheet export scheduling feature. This
allows you to export timesheets to a file on the server (or network drive) where Pacific
Timesheet is installed. The following options are provided:

Options Description
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Schedule Enabled Check this option to enable scheduled timesheet exporting.

Schedule The schedule or frequency for timesheet exporting. The time
period can be any created in the System > General > Time
Periods page. To specify the exact time within the time period
when the export occurs you specify an offset (in hours:minutes)
from the start or end of the time period. For instance, if you want
to export  timesheets at 4:30 PM (16:30) on the last day of the
time period, you would specify "7:30 hh:mm before the period
ends".

Next Run As you modify the schedule, this property will update to show
when the next export will occur.

Export Directory The file path to the directory where the export file will be
created, e.g. "/tmp", "c:\exports" or "\\morpheus\\c\exports".
The path must be valid for the server that Pacific Timesheet is
installed on.

File Name The name of the export file, e.g. "timesheets-for-payroll". The
"Append timestamp" option will add the date and time of the
export to the file name, e.g.
"timesheets-for-payroll.200908150831". Note that the file
extension will automatically be added when the export file is
created, based on the Format property, described below. For CSV
format, the file extension ".csv" will be added to the file name.
For MS Excel format, the file extension ".xls" will be added to the
file name.

Format The format of the export file, either comma-separated-values
(CSV) or Microsoft Excel (XLS). 

Time Period The time period to use when searching for timesheets to export.
For example, you might schedule the export to occur weekly, but
want to export the previous week's timesheets.

Status Select a value if you want to only export timesheets with a
particular status, such as submitted or approved.

Group Select a value if you want to only export timesheets for
employees in a particular group.

Export Status Select a value if you want to only export time entries that are
either unexported or exported. Time entries are only marked as
exported if the "Mark as Exported" option is selected (described
below).

Mark as Exported Checking this option will mark each exported time entry as
having been exported. This works in conjunction with the "Export
Status" filter option, described above.

-o-
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QuickBooks Export File
QuickBooks Export File

Intuit QuickBooks Pro allows the importing data from an external source. Pacific Timesheet
provides a QuickBooks-compatible timesheet export file that you can use to transfer time
activities directly into QuickBooks for both invoicing and payroll. The format of the file is the
Intuit Interchange Format (IIF), and uses the Timer Activity import feature of QuickBooks.

Note: More advanced QuickBooks integration, including bi-directional transfer of jobs,
employees and codes, is supported through the Time Bank data integration facility. You
can find out more by contacting your sales representative or visiting our website at 
http://www.pacifictimesheet.com/.

To set up your system for proper export you will need to configure the following properties:

Property Description

Enabled Check this option to enable the QuickBooks export file support.
When enabled you will see an "Export - QuickBooks" item in the
options menu on the Timesheets and Approvals tabs.

Company The QuickBooks company name. This value is found by doing a
Timer Activity Export from QuickBooks, as detailed below.

Company Create Time The QuickBooks company create time. This value is found by
doing a Timer Activity Export from QuickBooks, as detailed below.

Template The QuickBooks timer activity export file template. This is detailed
below.

You can control which time entries are exported by specifying any of the following filters:

Property Description

Billable Filter Use this filter to export only billable or non-billable hours. You
might use this filter if you are only using QuickBooks for billing,
for instance.

Payable Filter Use this filter to export only payable or non-payable hours.

Hours Filter Use this filter to only export work hours or leave hours.

Employee Filter Use this filter to only export specific employee types.

Getting the Company Name and Create Time

The first step to configuring your system for proper QuickBooks exporting is to determine
the Company name and Company Create Time. To do this you need to start QuickBooks Pro
and run the Timer Lists export under the File > Utilities > Export menu. Save this file to a
convenient location and open it with a text editor such as Notepad or Wordpad. Look for
lines like the following: 

!TIMERHDR VER REL COMPANYNAME IMPORTEDBEFORE FROMTIMER
COMPANYCREATETIME
TIMERHDR  7  0 ArpentN Y 1165339129

The TIMERHDR line has the Company name and Company Create Time values we need. In
this case the Company name is Arpent, and the Company Create Time is 1165339129.

The TIMERHDR fields are:
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VER The version number of the QuickBooks Timer, for example 7. You
can find this information by first running an Timer Activity export
in QuickBooks and viewing the output. You will need to modify the
template replacing the example value with your specific value.

REL The release number of the QuickBooks Timer. You can find this
information by first running an Timer Activity export in
QuickBooks and viewing the output. You may need to modify the
template to replace the example value with your specific value,
otherwise QuickBooks may generate a warning message when
importing the data.

COMPANYNAME The name of your QuickBooks company. If you leave this as
${System.company} it will be automatically substituted with the
Company property entered above.

FROMTIMER Indicates whether you are exporting or importing data.  It should
always be the value "Y".

COMPANYCREATETIME A unique number that comes from your QuickBooks Pro company
file.  You can find this information by first running an Timer
Activity export in QuickBooks and viewing the output. You will
need to modify the template replacing the example value with
your specific value.

Configuring the Template

The export file generated by Pacific Timesheet will contain the TIMERHDR records above, as
well as TIMEACT records for each timesheet's time entries. The format of a TIMEACT might
look like the following:

!TIMEACT DATE JOB EMP ITEM PITEM DURATION PROJ NOTE
XFERTOPAYROLL BILLINGSTATUS
TIMEACT 3/25/08 ABCompany:Job 123 Bill Williams Support 02:00

N 1

The TIMEACT fields are:

DATE The date the activity was performed, in MM/DD/YY format. This is
generally set to the variable ${TimeEntry.date}, described below.

JOB The QuickBooks job, which is in the format Customer:Job. This is
generally set to the variable ${Customer.name}:${Project.name},
described below.

EMP The name of the employee. This is meant to map to the
QuickBooks employee name and must match exactly. Outputted
as "Lastname, Firstname" by default. This is generally set to the
variable ${User.name} or ${User.fullName}, described below.

ITEM The name of the service item assigned to the activity. This is
generally set to the variable ${Task.name}, described below.

PITEM The name of the payroll item. This is generally set to the variable
${PayCode.name}, described below.

DURATION This is the duration of the activity in hours and minutes, in HH:MM
format. This is generally set to the variable ${TimeEntry.hours},
described below.

NOTE This field contains the timesheet cell notes. Note that any newline
or tab characters will be replaced with a space on the export. This
is generally set to the variable ${TimeEntry.notes}, described
below.
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XFERTOPAYROLL "N" if not for payroll, or "Y" if for payroll.

BILLINGSTATUS Indicates the billing status of the activity, either "1" for billable, or
"0" for non-billable. By default populated with the Task billable
status. This is generally set to the variable ${TimeEntry.billFlag},
described below.

You can control which values from Pacific Timesheet are substituted into the TIMEACT
records by editing the template. The following template variables are supported:

Variable Description

${TimeEntry.date} The date of the time entry, formatted as m/dd/yy (the standard
QuickBooks date format). This is generally used for the DATE field
of a TIMEACT record.

${TimeEntry.hours} The time entry hours, formatted as hours:minutes (the standard
QuickBooks hours format). This is generally used for the
DURATION field of a TIMEACT record.

${TimeEntry.notes} The time entry notes, if any. This is generally used for the NOTE
field of a TIMEACT record.

${TimeEntry.billFlag} The time entry billable flag, with the value "0" if the time entry is
not billable, or "1" if the time entry is billable.

${Customer.name} The name of the Customer for this time entry. This is generally
used for the JOB or ITEM field of a TIMEACT record. Note that
even if you customized the terminology and renamed Customer to
something else (e.g. Client), you still use Customer.name for the
variable name.

${User.name} The name of the employee, formatted "Lastname, Firstname". This
is generally used for the EMP field of a TIMEACT record.

${User.fullName} The name of the employee, formatted as "Firstname Lastname".
This is generally used for the EMP field of a TIMEACT record.

${User.id} The ID of the employee. This is generally used for the EMP field of
a TIMEACT record.

${Customer.id} The ID of the Customer for this time entry. This is generally used
for the JOB or ITEM field of a TIMEACT record. Note that even if
you customized the terminology and renamed Customer to
something else (e.g. Client), you still use Customer.id for the
variable name.

${ProjectGroup.name} The name of the Project Group for this time entry. This is
generally used for the JOB or ITEM field of a TIMEACT record. Note
that even if you customized the terminology and renamed Project
Group to something else (e.g. Client Portfolio), you still use
ProjectGroup.name for the variable name.

${ProjectGroup.id} The name of the Project Group for this time entry. This is
generally used for the JOB or ITEM field of a TIMEACT record. Note
that even if you customized the terminology and renamed Project
Group to something else (e.g. Client Portfolio), you still use
ProjectGroup.id for the variable name.

${Project.name} The name of the Project for this time entry. This is generally used
for the JOB or ITEM field of a TIMEACT record. Note that even if
you customized the terminology and renamed Project to
something else (e.g. Job), you still use Project.name for the
variable name.
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${Project.id} The ID of the Project for this time entry. This is generally used for
the JOB or ITEM field of a TIMEACT record. Note that even if you
customized the terminology and renamed Project to something
else (e.g. Job), you still use Project.id for the variable name.

${TaskGroup.name} The name of the Task Group for this time entry. This is generally
used for the JOB or ITEM field of a TIMEACT record. Note that
even if you customized the terminology and renamed Task Group
to something else (e.g. Phase), you still use TaskGroup.name for
the variable name.

${TaskGroup.id} The ID of the Task Group for this time entry. This is generally
used for the JOB or ITEM field of a TIMEACT record. Note that
even if you customized the terminology and renamed Task Group
to something else (e.g. Phase), you still use TaskGroup.id for the
variable name.

${Task.name} The name of the Task for this time entry. This is generally used
for the JOB or ITEM field of a TIMEACT record. Note that even if
you customized the terminology and renamed Task to something
else (e.g. Activity), you still use Task.name for the variable name.

${Task.id} The ID of the Task for this time entry. This is generally used for
the JOB or ITEM field of a TIMEACT record. Note that even if you
customized the terminology and renamed Task to something else
(e.g. Activity), you still use Task.id for the variable name.

${PayCode.name} The name of the Pay Code for this time entry. This is generally
used for the PITEM field of a TIMEACT record. Note that even if
you customized the terminology and renamed Pay Code to
something else, you still use PayCode.name for the variable name.

${PayCode.id} The ID of the Pay Code for this time entry. This is generally used
for the PITEM field of a TIMEACT record. Note that even if you
customized the terminology and renamed Pay Code to something
else, you still use PayCode.id for the variable name.

Note that when using the .name variables you need to be careful to match the names in 
Pacific Timesheet with the names in QuickBooks. If your names in Pacific Timesheet cannot
be made identical to those in QuickBooks you will want to use the ID field instead. Change
the appropriate template fields to use the .id variables instead, then update the ID property
of the employees, projects or other objects in Pacific Timesheet with the name as it appears
in QuickBooks.

Exporting To QuickBooks

Once you have configured the company name, company create time and template as
needed, you can generate the QuickBooks export file. To do this click on the Timesheets or
Approvals tab in Pacific Timesheet and list the timesheets you are interested in exporting.
Click the options menu (the icon button with a small triangle to the upper-right of the
timesheet list) and choose the "Export - QuickBooks" item. Save the resulting file to the
appropriate location on your computer. 

Next, start QuickBooks Pro, then go to the File > Utilities > Import > Timer Activities and
import the file you just saved. QuickBooks will import the data and generate a detailed
report of the import results. You can import data as often as your needs require, but be
careful not to import the same file twice as QuickBooks will generate duplicate timer
activities.

-o-
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Auto-Import Directory (Self-Hosted Version Only)
Auto-Import Directory

The auto-import directory provides another way for you to import data into Pacific
Timesheet. When CSV files are dropped into the auto-import directory they will be
automatically imported into the system. The format of the import files is exactly the same
as when you import through the web browser. For information about the CSV import file
format see the Importing/Exporting topic.

To set up a directory for auto-importing you need to configure the following properties:

Property Description

Enabled Check this option to enable auto-importing.

Directory The directory to monitor for CSV import files. This is a file path on
the server computer where the Pacific Timesheet service is
installed. 

Note that you will need to make sure that the directory has
read/write permissions for the user account that the Pacific
Timesheet service is running under.

When Finished This option determines what to do to the file when finished, so
that it will not be reprocessed. The following options are available:

Delete Delete the file after successfully importing the
data.

Rename Rename the file by appending ".fin" after
successfully importing the data.

File Naming

Import files need to be named in a specific way in order for the system to know how to
process it: 

1. The file name must end is ".csv"

2. The file name must start with the type of objects being imported, then a hyphen, then
the key field, and finally a hyphen:

objects-keyfield-*.csv

The first part, 'objects', is the type of objects being imported, such as employees or tasks.
The next part, 'keyfield', is the object property to use to avoid creating duplicates, for
instance name or id. The '*' is a wild-card indicating that any valid file name text can
appear after the hyphen. For example, to import employees using the login name as the key
field the following file name would be appropriate:

employees-login-myemployees.csv

The following objects and key fields are available:

Objects Key Fields Notes
employees login, id, email
employee-balances (none) No key field needed
groups name, id
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customers name, id If you renamed customers using the terminology
feature then use your plural terminology, making
sure to remove any spaces, if any, in the name.
For example: clients-name-myclients.csv

projectgroups name, id If you renamed project groups using the
terminology feature then use your plural
terminology, making sure to remove any spaces,
if any, in the name. For example:
portfolios-name-myportfolios.csv

projects name, id If you renamed projects using the terminology
feature then use your plural terminology, making
sure to remove any spaces, if any, in the name.
For example: jobs-name-myjobs.csv

taskgroups name, id If you renamed task groups using the
terminology feature then use your plural
terminology, making sure to remove any spaces,
if any, in the name. For example:
phases-name-myphases.csv

tasks name, id If you renamed tasks using the terminology
feature then use your plural terminology, making
sure to remove any spaces, if any, in the name.
For example: activities-name-myactivities.csv

timesheets (none) No key field needed
billrates (none) No key field needed. For example:

"billrates-.csv", "billrates-xyz.csv", etc.
payrates (none) No key field needed. For example:

"payrates-.csv", "payrates-xyz.csv", etc.

Note that these file naming conventions are case-insensitive.

Logging and Error Handling

An import log file will be generated in the auto-import directory, with details about what was
imported, and any errors that might have occurred. Up to 7 days of log files will be
generated - older ones will be deleted automatically. 

If any errors occur during the import, the import file will be renamed by appending ".err" to
the file. 

-o-
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License
License

Enter your license key on this page. After clicking OK your new license will take effect
immediately.

The license limits how many active employees your system may have. There is no limit on
how many inactive users you may have, so in general you need never delete terminated
employees, just inactivate their accounts.

If you are hosting the software yourself, a free, non-expiring 10-employee license is
generated when installed. This free license does not come with any technical support. You
can purchase a support contract or a license for more employees by contacting your Pacific
Timesheet reseller or sales@pacifictimesheet.com, or visiting www.pacifictimesheet.com.
When ordering a new license you will be asked to provide the host computer name, which
can be found on System > General > License page.

-o-
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System Lists
System Lists

System lists are collections of named values that you can modify, such as Employment
Types. You might need to modify lists when integrating with external systems such as
payroll applications.

List items have the following properties:

Property Description

Name The name of this item, up to 255 characters.

Value The value for this item, up to 255 characters.

-o-
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Pay Codes
Pay Codes

Pay codes are used to categorize time entries. For instance you might use pay codes like
Regular Time or Over Time for work time entries, and pay codes like Sick or Vacation for
leave time entries.

Note: Some built-in pay codes have special uses, and changes to them should be carefully
considered. For instance, to avoid confusion you would not want to rename Holiday to
Vacation, or rename Over Time to Double Time. The following built-in pay codes have
special uses:

Regular Time, Over Time and Double Time are used by the Over Time Rules (see the
Policies topic for more information).

Flex Time is used by the Flex Time Rules (see the Policies topic for more information).

Holiday is used when placing holidays onto timesheets by the Schedule Rules (see the
Policies topic for more information).

Note: You can change the terminology for Pay Code, Work and Leave to suit your
organization's needs. The Terminology topic has more information.

Pay codes have the following properties:

Property Description

Name The pay code name, up to 80 characters. A value is required and
must be unique for all pay codes.

Description A description for the pay code, up to 255 characters.

ID The pay code ID, up to 80 characters. This value is not required, but
if a value is entered it must be unique for all pay codes. This is
commonly used for synchronizing with external systems, such as
payroll or accounting.

Status The pay code status, either Active or Inactive. You cannot delete pay
codes that have been used on timesheets. Setting the status to
inactive will prevent any further use of the pay code.

Type The pay code type, either Work or Leave. This property can only be
changed when creating a new pay code - once a pay code has been
created you cannot change its type.

Note that the terminology for Work and Leave can be changed from
the General page under the System tab.

Can Request If checked then this pay code can be requested from the employee's
Home tab. For instance, you might want the "Vacation" pay code to
be requested, but it would not make sense for the "Sick" pay code to
be requested.

Balance Enabled If enabled, a balance will be tracked for this pay code. This only
applies to Leave pay codes, such as Vacation. Hours recorded against
this pay code will automatically be deducted from the associated
balance. The Employee Balances topic has more information.

Color The color is used on employee calendars when shading days with
leave requests or holidays. Employee calendars appear on the Home
tab or the Employees tab.
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Notes Notes about this pay code, up to 2000 characters.

Permissions

Permissions allow you to restrict which pay codes employees can access on their
timesheets. Employees with a Permission Level that gives them only limited viewing
permission, for instance, will only be able to access pay codes for which they have been
added to the permission list.

-o-
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Templates
Timesheet Templates

Timesheet templates define the type and layout of time entry fields for employee
timesheets. You can create any number of timesheet templates, which gives you great
flexibility in the types of timesheets you assign to employees. For instance you might
require hourly workers to record their start and finish times, whereas others might just
track total hours.

Timesheet templates are assigned to an employee from the Employee Details page. See the 
Managing Employees topic for more information.

Timesheet templates have the following properties:

Property Description

Name The template name, up to 80 characters. A value is required and
must be unique for all templates.

Description A description for the template, up to 255 characters.

Status The template status, either Active or Inactive. You cannot delete
templates that are currently assigned to employees. Setting the
status to inactive will prevent the template from being assigned to
new employees.

Time Period The time period for this template. The Time Periods topic has more
information.

Time Entry Style Choose Normal to have employees enter their time in hours, which is
the most common choice. Choose Percent to have employees enter
their time as a percentage of their scheduled hours.

Default This determines whether this template is the default timesheet
template for new employees.

Timesheet Fields The list of time entry fields that appear in the main section of the
timesheet. The fields will appear in the order specified. For each field
you can specify the following options:

Work Only: If checked, this field will only be shown on work rows,
otherwise it will be shown on both work and leave rows.

Required: If checked then a value is required for this field. If no value
is provided then timesheet will generate an error message and will be
prevented from being submitted.

Detail Fields The list of time entry fields that appear in the Details section of the
timesheet. The fields will appear in the order specified. As for
timesheet fields above, you can specify whether each field is Work
Only or Required.

Total Fields The list of fields that appear in the Totals section of the timesheet.

Property Description

Time Entries
Allowed

This option allows you to limit time entries on for this timesheet
template to just work or leave. For instance, if you are only tracking
leave or time off you would set this value to "Leave".
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Time Entry Mode This determines whether the employee enters hours on their
timesheet (Standard), enters time as a percent of their total time
spent working (Percent Time Entry), or just checks whether they
were present or absent (Presence/Absence Time Entry).

Attendance Entry If this option is checked then the Attendance Widget will be shown at
the top of the timesheet. This option is only useful if you are not
capturing start and finish times on the timesheet itself.

Attendance Hours If Attendance Entry is enabled you can use this property to require
whether attendance hours must match timesheet hours. Users will
not be able to submit their timesheets unless the hours match if this
option is set.

Property Description

Submit Message A custom message to display to employees when they submit their
timesheets.

The following time entry fields are available:

Property Description

Start The start time for the time entry. Times are entered in the format
appropriate for the employee's locale.

Finish The finish time for the time entry. Times are entered in the format
appropriate for the employee's locale.

Hours The number of hours for the time entry. The format can be entered in
either decimal or hh:mm format.

Pay Code The pay code for the time entry.

Project Group The project group for the time entry.

Project The project for the time entry.

Task Group The task group for the time entry.

Task The task for the time entry.

Bill Rate The bill rate for the time entry.

Bill Amount The bill amount for the time entry.

Pay Rate The pay rate for the time entry.

Pay Amount The pay amount for the time entry.

You can preview what the timesheet will look like by clicking the Preview button on the
Timesheet Template Details page.

-o-
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Policies
Policies

Policies are sets of rules governing the behavior of employee timesheets, leave accrual and
more. You can create any number of policies and assign different policies to different
employees. For instance, you might have one policy for exempt employees titled "Exempt
Policy", and another policy for hourly employees named "Hourly Policy", each with different
rule settings. Each employee must have a policy, which is specified in the Employee Details
page.

Policies are composed of several sets of related rules. This includes Time Entry Rules,
Balance and Accrual Rules, Over Time Rules and Flex Time Rules. Policies have the
following properties:

Property Description

Name The policy name, up to 80 characters. A value is required and
must be unique for all policies.

Description A description for the policy, up to 255 characters.

Status The policy status, either Active or Inactive. You cannot delete
policies that are currently assigned to employees. Setting the
status to inactive will prevent the policy from being assigned
to new employees.

Default This determines whether this policy is the default policy for
new employees.

Policy Rules

 Time Entry Rules
 Schedule Rules
 Balance and Accrual Rules
 Over Time Rules
 9/80 Over Time Rules
 Flex Time Rules

-o-
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Time Entry Rules
Time Entry Rules

Time entry rules can be used to control how many hours an employee can enter on a
timesheet, as well whether time entries are rounded or not. If any rule is violated an error
will appear on the timesheet, and the timesheet cannot be submitted for approval until the
rule violation is corrected.

You can control how many hours the employee may take per day or week with the following
rules:

Rule Description

Minimum hours per day The minimum number of hours that should be entered each
work day, Monday through Friday. This rule is checked when
the timesheet is submitted, and counts both work and leave
hours in the day total. For example, if you enter 8.00 hours
for this value then the employee must record 8 hours of work,
sick, vacation, etc. for each day of the work week, or they will
not be able to submit their timesheet.

Maximum hours per day The maximum number of hours that can be entered per day.

Minimum hours per week The minimum number of hours that can be entered per week.
This rule is checked when the timesheet is submitted, and
counts both work and leave hours in the week total.

Maximum hours per week The maximum number of hours that can be entered per week.

Minimum hours per period The minimum number of hours that can be entered per
period. This rule is only useful for timesheet periods that are
longer than one week. This rule is checked when the
timesheet is submitted, and counts both work and leave hours
in the period total.

Maximum hours per period The maximum number of hours that can be entered per
period. This rule is only useful for timesheet periods that are
longer than one week.

You can restrict how many hours of leave an employees may take per day by setting the
following rules:

Rule Description

Flex Time minimum hours
per day

If an employee puts Flex Time hours on their timesheet, this
is the smallest amount that can be taken in one day.

Flex Time maximum hours
per day

The maximum Flex Time hours that can be taken in one day.

Holiday minimum hours
per day

If an employee puts Holiday hours on their timesheet, this is
the smallest amount that can be taken in one day.

Holiday maximum hours
per day

The maximum Holiday hours that can be taken in one day.

Sick minimum hours per
day

If an employee puts Sick hours on their timesheet, this is the
smallest amount that can be taken in one day.

Sick maximum hours per
day

The maximum Sick hours that can be taken in one day.

Vacation minimum hours
per day

If an employee puts Vacation hours on their timesheet, this is
the smallest amount that can be taken in one day.
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Vacation maximum hours
per day

The maximum Vacation hours that can be taken in one day.

Note that the above list will vary depending upon your configured leave pay codes. Also note
that if you set the minimum and maximum to be the same for a given pay code, this implies
the employee cannot take a partial day of leave. When generating a leave request for the
given pay code the employee will not see the "Partial Day" option.

Rounding rules allow you to control rounding of punches:

Rule Description

Round time entries to The number of minutes to round time entries to, for example
15.

Rounding Mode How rounding is done, either Nearest, Round Up or Round
Down.

You can automatically deduct meal time from punches using the following rules:

Rule Description

Automatic meal deduction Check this option to automatically deduct the specified
minutes from time entries. You might specify, for instance,
that 30 minutes are deducted from time entries that are 8 or
more hours. This is done by splitting the time entry into two
parts, and taking the deduction from the middle of the time
entry. In this way the employee's start and finish times, if
entered, are always preserved.

Apply to entries at least If automatic meal deduction is enabled then you need to
specify the smallest punch that gets a meal deduction. For
instance, you may only want a meal deduction for time
entries that are 8 hours or larger.

Note that the punch having the meal deducted will be split into two punches, with a meal
break in the middle. In this way the punch in and out times are preserved. The meal will fall
in the middle of the punch, starting at the nearest whole hour.

For some payroll applications you may need to break or split time entries at midnight:

Rule Description

Automatic midnight split Check this option if you want punches that span midnight to
be split into two punches - one ending on midnight and one
starting at midnight. This will prevent hours that are worked
after midnight from being booked to the timesheet period in
which the punch was started.

The default timesheet rule controls which timesheet period the employee is presented with
when they log into Pacific Timesheet:

Rule Description
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Default Timesheet Check this option if you want to change the default timesheet
period that loads when an employee logs in. Normally the
current timesheet is presented, but you can alternatively have
the previous timesheet, if not submitted, be presented. The
mandatory option is for cases where you want the employee
to fill out and submit their previous timesheet before moving
to a new one.

-o-
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Schedule Rules
Schedule Rules

Schedule rules can be used to prevent employees from entering more or less hours than
they are scheduled for. You set an employee's scheduled hours from the Employee Details
page.

The following rules can be configured:

Rule Description

Timesheet hours cannot be
greater than scheduled
hours

Requires the employee to put no more than their scheduled
number of hours on the timesheet. The timesheet cannot be
submitted until they correct this.

Timesheet hours cannot be
less than scheduled hours

Requires the employee to put no less than their scheduled
number of hours on the timesheet. The timesheet cannot be
submitted until they correct this.

Add Holidays to timesheet If checked then any Holidays the employee can take will be
put on their timesheet automatically.

Add Leave requests to
timesheet

If checked then approved Leave Requests will be put on the
employee's timesheet automatically.

Don't allow submitting of
Leave requests with
conflicting or overlapping
dates

If checked then employees will not be able to submit leave
requests that conflict with other leave requests they may
have submitted for the same dates.

-o-
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Flex Time Rules
Flex Time Rules

Flex time (also called Comp time) rules allow you to automatically accrue hours into the Flex
time balance.

The following rules can be configured:

Rule Description

Daily work hours over Any work hours over this amount in a single day will result in
an equal number of hours being added to the Flex time
balance. You can override this value and specify individual
values for each day of the week, too.

Weekly work hours over Any work hours over this amount in a single week will result
in an equal number of hours being added to the Flex time
balance. This rule is processed after any daily rules.

Period work hours over Any work hours over this amount in a timesheet period will
result in an equal number of hours being added to the Flex
time balance. This rule is processed after any weekly rules.
This rule is only useful for timesheet periods that are longer
than one week.

-o-
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Balance and Accrual Rules
Balance and Accrual Rules

Balance and accrual rules control how balances limits and accruals are handled. Balances
are associated with Pay Codes, and can be enabled from the Pay Code properties page. The
following rules can be configured for each enabled balance:

Rule Description

Minimum Balance The minimum value for this balance, in hours. Employees will
be alerted when their timesheet puts a balance below this
value, and they will not be able to submit the timesheet.

Maximum Balance The maximum value for this balance, in hours. The balance
will be capped at this value.

Enable Accrual Enables automatic accrual on this balance.

Calculate Accruals This setting only is available if accruals are enabled. You can
choose one of three ways to compute accruals:

1. Hourly - For Every Hour Worked

Hours are accrued at 12 noon of the last day of the timesheet
period, based on the number of work hours recorded on the
timesheet. The accrual calculation is performed when the
timesheet is submitted.

2. Monthly - For Every Month Employed

Hours are accrued at 12 noon on the last day of every full
month of employment.

3. Yearly - For Every Year Employed

Hours are accrued at 12 noon on the last day of every full
year of employment.

Rollover/accrual
sequencing

This controls whether an annual rollover runs before or after
an accrual that would fall on the same date. For instance, if
you are running monthly or annual accruals they will occur on
the last day of the time period, late in the day on December
31. Calendar year annual rollovers also occur on the last day
of the time period, late in the day on December 31. For
monthly accruals you may prefer to have the rollover run 
after the December accrual. But for annual accruals you may
want the rollover to run before the accrual to avoid having the
new accrual be immediately erased.

Move Excess Rollover
Hours To

This setting only is available if accruals are enabled. If you
specify a non-blank rollover value, you can have excess hours
(hours over the rollover value) be placed in a separate
balance. For instance, you might cap annual rollovers for the
'Sick Leave' balance at 0.00, and have any left-over hours be
placed in an 'Extended Sick Leave' balance.

Forecast only If this option is checked then no accruals will actually be
added to the balance. All of the accrual settings will only be
used in forecasting an employee's available hours when
requesting leave. You would only want to check this option if
you are importing or synchronizing your balances from an
external payroll or HR system.
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When you enable accruals an accrual rate table will appear:

Property Description

Years Employed The number of years of employment for this rate to take
effect.  If you only have one row in your accrual table this
property will be hidden and default to zero, meaning the rate
will apply to all employees, regardless of their years of
employment.

The number of years of employment is determined by the
employee's First Day property (see the Employees topic for
more details). If the employee's first day is not set then it is
assumed to be zero years.

Accrual Rate The accrual rate for this balance, in hours. Accruals will be
automatically granted on the final day of each month.

Max. Work This column only appears if the "Calculate Accruals" property
is set to "Hourly - For Every Hour Worked". This is the
maximum number of work hours to consider when calculating
the accrual, for example 40 for a weekly timesheet period, or
80 for a biweekly timesheet period.

Maximum The cap or maximum hours the balance can reach.

Rollover The maximum hours that can be carried forward each year for
this balance. The balance will be capped at this value at 12
midnight, January 1 of each new year. Leave this value blank
if there is no maximum annual rollover.

If you don't vary accrual rates or rollovers based on the years of employment you will only
need one row in the accrual table. Otherwise click the Add button to add as many rows as
you need.

-o-
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Over Time Rules
Over Time Rules

Over time rules allow you to automatically compute over time and double time on employee
timesheets.

Note: Make sure you do not turn on both the regular over time rules and the 9/80 over
time rules for the same policy. There should be at most ONE type of over time rules
enabled for a policy.

The following rules can be configured for over time and double time:

Rule Description

Daily work hours over Any work hours over this amount in a single day will be
marked as over time. You can override this value and specify
individual values for each day of the week, too.

Weekly work hours over Any work hours over this amount in a week will be marked as
over time, after the daily rule is processed.

Period work hours over Any work hours over this amount in a timesheet period will be
marked as over time, after the weekly rule is processed. This
rule is only useful for timesheet periods that are longer than
one week.

Note that rules are processed in the above order, and that double time rules are processed
after all over time rules are processed.

In addition to the above rules, you can specify consecutive days rules:

Rule Description

Consecutive days rules
start after

The number of consecutive days of work before the
consecutive days rules are applied. This can include days
worked prior to the current week (the "consecutive days"
option), or only consecutive days with the work week (the
"consecutive days in a work week" option).

Work hours over [  ] are
Over Time

Any work hours over this amount on a consecutive day will be
over time.

Work hours over [  ] are
Double Time

Any work hours over this amount on a consecutive day will be
double time.

Options allow you specify additional time entry pay codes that you would consider as
regular work hours. For instance, some organizations consider Holiday hours to contribute to
the total regular hours. If so, you would add the Holiday pay code to the list.

Example

As an example, here is how California, U.S. over time rules would be configured:

Over Time Rules:

[x] Daily work hours over  [ 8.00]

[x] Weekly work hours over [40.00]

Double Time Rules:

[x] Daily work hours over  [12.00]

[x] Weekly work hours over [60.00]
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Consecutive Days Rules:

[x] Consecutive days rules start after: [6] [consecutive days in a work week]

    On those consecutive days:

    Work hours over: [ 0.00] are Over Time

    Work hours over: [ 8.00] are Double Time

-o-
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9/80 Over Time Rules
9/80 Over Time Rules

For employees working a compressed 9/80 work schedule you will want to use the 9/80
Over Time Rules rather than the regular Over Time Rules. The 9/80 rules will correctly
compute overtime for compressed weeks, taking into account hours worked in the previous
week.

Note: Make sure you do not turn on both the regular over time rules and the 9/80 over
time rules for the same policy. There should be at most ONE type of over time rules
enabled for a policy.

The following rules can be configured for over time and double time:

Rule Description

Weekly Hours The maximum number of work hours per week considered
"regular time", for example 40. Work hours over this value
will be considered over time. 

Midpoint The time and day of the week that is considered the end of
the week (or the midpoint of the two week cycle), for example
Friday 12:00 noon.
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Work Shift Rules
Work Shift Rules

Work shift rules are used to compute how many hours an employee worked fall into each
defined work shift. Before setting up your work shift policies you need to define your work
shifts, on the System > General > Work Shifts page. The Work Shifts topic has more
information. 

When configuring your work shift rules you can specify the following properties:

Rule Description

Enabled Shifts This is the list of enabled work shifts for this policy. Work
shifts are global objects, but you can selectively
enable/disable different ones for each policy. For instance,
you might have two different night shifts: one from
10PM-6AM for employees at one  location, and one from
12AM-8AM at another location. You can then create two
policies and enable the appropriate night shift for each policy.

Shift Hours Depend On This property determines how a work time entry has its hours
associated with the appropriate work shift. The possible
options are:

1. Each Shift Worked

Hours are proportioned into each shift that the time entry falls
on. For instance, if all 8 hours are worked in Shift 1 then all 8
hours are associated with Shift 1. But, instead, if half the
work was in Shift 1 and the other half in Shift 2 then each
would get 4 hours.

2. Largest Shift Worked

All work hours are put into the work shift that had the most
hours. For instance, if an employee worked 8 hours, with 2
hours in Shift 1 and 6 hours in Shift 2, then Shift 1 would get
zero hours and Shift 2 would get 8 hours.

3. First Shift Worked

All work hours are put into the first work shift. For instance, if
an employee worked 8 hours, with 2 hours in Shift 1 and 6
hours in Shift 2, then Shift 1 would get 8 hours and Shift 2
would get zero hours.

-o-
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Wage Rules
Wage Rules

Wage rules help keep you in compliance with governmental rules regarding missed meals,
split shifts and other work issues affecting employee wages and benefits.

Automatic Missed Meal Premium

Also called a "missed meal penalty", the automatic missed meal premium rule allows you to
credit an employee with regular time hours (the premium) for every missed meal in a block
of work. The following properties are supported:

Property Description

Add The number of regular hours (the premium) to add for every
missed meal, for example 1.00. These hours are added to the
regular time pay code for the time entry that incurred the
missed meal.

For every The minimum number of continuous hours that must be
worked before a meal is considered missed, for example 5.00.
Any hours worked over this value without a meal break will
trigger the missed meal penalty.

Waive If Waives the second missed meal if hours worked are over this
value. If hours worked are over twice this value then no waive
occurs. A blank value means no waive occurs.

Minimum Meal The minimum number of hours that constitute a meal, e.g.
0.5 (30 minutes).

Adjust regular hours If checked the missed meal hours (the premium) will be
added to the regular time hours for the time entry.

Adjust pay amount If checked the pay amount will be increased by the missed
meal hours (the premium) * pay rate for the time entry.

Note: Only one missed meal premium will be computed each day. 

The additional regular hours or premium is added to the employee's regular hours for the
appropriate time entry. Also, the pay amount for that time entry will be increased by the
appropriate amount (regular hours x employee's pay rate). 

To make it easier to report on missed meal premiums, you can optionally define the
following two custom timesheet fields: "Meal Penalty Hours" and "Meal Penalty".

The "Meal Penalty Hours" field is the number of regular hours (the premium) added. This
is a number field, and is created from the System > Templates > Manage Custom Fields
page. You must name the field exactly as  shown (without the quotes). Once you have
created the field, you can later edit it and change the name if desired without affecting
operation. 

The "Meal Penalty" is the premium (number of regular hours added) multiplied by the
employee's pay rate. This is a currency field, and is created from the System > Templates
> Manage Custom Fields page. You must name the field exactly as  shown (without the
quotes). Once you have created the field, you can later edit it and change the name if
desired without affecting operation.

If you want to waive the missed meal calculation for a day you can create a checkbox
custom field named "Meal Penalty Waiver" and put it on the timesheet details. If checked
for a time entry that has a missed meal premium (visible by the comment added), then the
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premium will be removed. You must name the field exactly as  shown (without the quotes).
Once you have created the field, you can later edit it and change the name if desired
without affecting operation.

Calculation Notes

Meal penalties are computed using a California lab law approach in which total work hours
are divided into blocks of, in the case of California, 5 hours. This can result in somewhat
surprising behavior. For instance, let's suppose an employee works the following hours in a
day:

     In       Out  Hours

 9:00AM   12:00PM   3.00

12:45PM    6:45PM   6.00

You might expect that the employee would be granted a missed meal premium for the
second punch as it exceeds 5 hours. This would not be the case, however. The first 5 hour
work block starts at 9:00AM and goes to 2:45PM (accounting for the meal break from
12:00PM to 12:45PM). As there was a meal break in that 5 hour block no penalty is granted.
The next 5 hour block starts at 2:45PM (not 12:45PM!). As the employee clocked out at
6:45PM there are only 4 hours in this block, so no penalty is granted.

Missed Meal Premium Example

A typical example would be that of California:

Add: 1.00
For Every: 5.00
Waive If:
Minimum Meal: 0.50

To waive the second meal in California the configuration would be:

Add: 1.00
For Every: 5.00
Waive If: 6.00
Minimum Meal: 0.50

Automatic Split Shift Premium

The automatic split shift premium rule allows you to credit an employee with extra pay (the
premium) for every split shift worked. A split shift is one in which a day's work is divided
into two or more parts separated typically by at least one hour. The following properties are
supported:

Property Description

Shift separation The number of hours between two work shifts that, if greater
than this value, would indicate a split shift. In other words, if
two work shifts in a single day have a time separation greater
than this value then they are considered a split shift.

Minimum wage The minimum wage used in computing the premium. The
premium is computed according to the following formula:

Premium = M - ((E - M) x H)

Where M = Minimum pay, E = Employee's hourly rate and H =
the number of hours worked.
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The additional pay or premium is added to the employee's pay amount for the appropriate
time entry.

To make it easier to report on split shift premiums, the additional pay or premium is also
added to a timesheet custom field named "Split Shift Premium". You can create this field
from the System > Templates > Manage Custom Fields page. You must create a currency
field named exactly as shown (without the quotes). Once you have created the field, you
can later edit it and change the name if desired without affecting operation.

If you want to waive the split shift calculation for a day you can create a checkbox custom
field named "Split Shift Waiver" and put it on the timesheet details. If checked for a time
entry that has a split shift premium (visible by the comment added), then the premium will
be removed. You must name the field exactly as  shown (without the quotes). Once you
have created the field, you can later edit it and change the name if desired without affecting
operation.

Split Shift Example:

A typical example would be a shift separation of 1 hour. Let's presume an employee works
two shifts with more than 1 hour between them, for example:

8:00AM - 12:00PM - 4 Hours
2:00 PM - 6:00PM - 4 Hours

If the employee has a pay rate of $10.00/hour, and the minimum wage is set to
$12.00/hour, then the premium or additional wage would be:

Premium = 12 - ((10 - 12) * 8) = 28

The employee would gain an additional $28.00 pay.

-o-
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Security
Security

The security page allows you to control security-specific application settings, such as
authentication and password policies. Security has the following properties:

Property Description

Expire Idle Sessions After The number of minutes of inactivity allowed before a login
expires.

Authentication Type Multiple types of authentication are supported through a
pluggable authentication architecture. The following
authentication types are provided in the base product
package:

 Standard
 LDAP/Active Directory

Refer to the appropriate topics below for more information on
configuring these authentication types.

Standard Authentication

Standard authentication provides basic login management and strong password support
from with the application - no external authentication sources are required. Passwords are
stored securely in the database using a one-way encryption algorithm. Standard
authentication has the following properties:

Property Description

Maximum Invalid Login
Attempts

The maximum number of invalid login attempts before the
account is locked. Locked accounts must be either unlocked
by an administrator, or can be unlocked by the user by
requesting a new temporary password. To disable this feature
enter a blank value.

Maximum Password Age The number of days before employees are asked to create a
new password. To disable this feature enter a blank value.

Maximum Password
History

Password history keeps employees from reusing previous
passwords. Enter the number of passwords you want to keep
in the history, or blank to disable this feature.

Minimum Password Length The minimum number of characters allowed in new
passwords. To disable this feature enter a blank value.

Minimum Lower Case
Characters

The minimum number of lower case characters allowed in new
passwords (a..z). To disable this feature enter a blank value.

Minimum Upper Case
Characters

The minimum number of upper case characters allowed in
new passwords (A..Z). To disable this feature enter a blank
value.

Minimum Numeric
Characters

The minimum number of numeric characters allowed in new
passwords (0..9). To disable this feature enter a blank value.

Minimum Special
Characters

The minimum number of special characters allowed in new
passwords (for example !,$#,%). To disable this feature enter
a blank value.

LDAP/Active Directory Authentication
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LDAP/Active Directory authentication allows you to authenticate employees against an LDAP
(Lightweight Directory Access Protocol) server. This includes Microsoft Active Directory when
it is configured with LDAP support (see the notes below). 

LDAP/Active Directory authentication has the following properties:

Property Description

LDAP Server The host name or IP address of the LDAP server.

LDAP Server Port The port number of the LDAP server. The default port number
is 389 (or 636 if using SSL).

Use SSL Check this option if you want to connect to the LDAP server
using SSL (Secure Socket Layer). This option will increase
your security by encrypting all communications between the
timesheet application and the LDAP server. Your LDAP server
must be configured for SSL for this to work.

Login The login name of a technical or administrative user, if this
LDAP server requires authentication. Depending upon your
directory server a simple login name might work, such as
"Directory Manager", or you might need to enter a
distinguished name such as 
"CN=ADMINISTRATOR,CN=USERS,DC=PACIFICTIMESHEET,D
C=COM". Note that for some Active Directory installations you
need to enter this in upper-case.

Another variant for Active Directory is of the form
admin@pacifictimesheet.com. This is the SAM account name
followed by the domain of the Active Directory server.

Password The login password.

Search Base The LDAP search base, which determines where a search for
employees will start. This is a distinguished name (DN), such
as "DC=pacifictimesheet,DC=com".

Search Filter The LDAP search filter, which is used to find employees in the
directory. The value depends on the type of of directory
server and how it is configured. For many open source LDAP
servers the following will work:

(&(objectClass=inetOrgPerson)(uid={0}))

For Microsoft Active Directory the following will generally
work:

(&(objectClass=user)(sAMAccountName={0}))

Logging Check this option to help troubleshoot authentication failures.
The log files can be viewed with a text editor, and are located
in the <PacificTimesheet>/tomcat/logs directory. 

You can test these settings by clicking the "Test Configuration" button. This will connect to
the specified LDAP server and perform a search, reporting any errors that arise.

You will still need to have an employee account in Pacific Timesheet for each employee that
will use the system. If an employee has an LDAP login but does not have a Pacific Timesheet
login they will not be able to log in. 

In the event of an LDAP failure, such as the directory server being unavailable, or no
matching user account being found in the directory, Pacific Timesheet will fail over to
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standard authentication. The entered login name and password will be checked against the 
Pacific Timesheet database. This ensures an administrator will still be able to log in using
the Pacific Timesheet account, and change the LDAP settings if need be. This also allows you
to have accounts in Pacific Timesheet that are not in the directory server, such as 'admin'.

When using LDAP authentication your employees will no longer see the "Change Password"
link on their home page (unless an LDAP failure occurred and the standard authentication
was used instead, as described above). 

Microsoft Active Directory Notes

You will need to enable LDAP support in Active Directory. Then add the object classes and
related attributes for the "inetOrgPerson" and "groupOfUniqueNames" object classes to the
Active Directory schema by using the Active Directory Management Console snap-in,
ADSIEdit. "groupOfUniqueNames" is defined in RFC 2256, "inetOrgPerson" in RFC 2798.

Related Topics

 Permission Levels
 Permission Lists

-o-
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Permission Levels
Permission Levels

Permission levels have the following properties:

Property Description

Name The name of the permission level, up to 80 characters.

Description A description of the permission level, up to 255 characters.

Status The status determines whether the access level appears in
lists or not. This is useful if you cannot delete an access level
because it is in use by one or more employees.

Object permissions include:

Permission Description

View Determines whether an employee with this permission level
can view all or a limited subset of the objects. If set to limited
then the employee must be assigned to the individual objects
you wish them to see.

Report Determines whether an employee with this permission level
can report on all or a limited subset of the objects. If set to
limited then the employee must be assigned to the individual
objects you wish them to report on.

Manage Determines whether an employee with this permission level
can manage all or a limited subset of the objects. If set to
limited then the employee must be assigned to the individual
objects you wish them to manage. Management permissions
include:

Edit Can change properties of the object.

Edit Advanced Can change advanced properties of the
object, which generally means anything
involving bill, pay and other monetary rates
and amounts.

Create Can create new objects of this type.

Delete Can delete objects of this type.

Import Can import objects of this type.

Export Can export objects of this type.

Customize Can manage custom fields for objects of
this type.

Approve Determines whether an employee with this permission level
can approve all or a limited subset of the objects. If set to
limited then the employee must be assigned to the individual
objects you wish them to approve.
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Can view my timesheet If not checked, the "My Timesheet" tab will not be shown,
even if the employee has a timesheet template in their
employee profile. This permission is useful for simplifying the
user interface for employees who meet all of the following
criteria:

1. They are not recording work hours
2. They are not required to submit their timesheet
3. They are only using the Leave Request feature on the

Home tab to record leave
4. Their employee policy's Schedule Rules is configured to

add leave requests to their timesheet

Can undo submit of my
timesheet

This applies to timesheet objects only, and determines
whether an employee can unsubmit (unlock) their timesheet.
Note that once a timesheet has been approved the employee
will not be able to unsubmit it, regardless of this permission.

Can edit my punches This applies to timesheets only, and determines whether an
employee can edit work time entries on their timesheet. If
this permission is not enabled then:

 Employees will not be able to edit the start, finish or hours
fields of their work rows manually.

 Employees will not be able to delete work rows from their
timesheets.

 Employees will not be able to delete their timesheet.

Employees will still be able to change the project or pay code,
enter notes, etc. of work rows. Also, this permission does not
affect leave rows - employees will be able to add leave rows
to their timesheet.

Can copy my previous
timesheet hours

This permission determines whether employees can have
timesheet memory carry forward hours from the previous
timesheet (this is set from the Home > Preferences page).
This permission also determines whether the employee sees a
"Copy Previous Timesheet" option on their timesheet. If this
permission is off then the employee can only carry forward or
copy rows from the previous timesheet.

Note that if you turn this permission off, but an employee has
already set their timesheet memory to carry forward rows and
hours, you will need to also change their timesheet memory
setting from Employees page.

Can punch from time clock
device only

Turning this permission on will allow an employee to only
punch in/out from a time clock device, ensuring their physical
presence. The employee will not be able to punch in/out from
a web browser. The employee will still be able to add leave to
their timesheet using a web browser, however.

-o-
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Permission Lists
Permission Lists

A permission lists is a set of users and groups given special permissions to access an object.
This is useful in larger organizations where you want to distribute some of the application
management tasks to mulitple employees. Another use is to limit which objects, such as
projects, tasks or paycodes, that an employee can view and add to their timesheets.

-o-
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Notices
Notices

Notices are emails that can be sent to employees for various events that occur in the
application. 

Note: You must configure the SMTP settings before being able to send email notices. The 
System Settings topic has more information.

The following notices can be sent:

Employee Late Notice

The Employee Late notice is sent to the approver of an employee who punches in after their
scheduled start time (see the Managing Employees topic for more information about the
scheduled start time). For late notices to be sent make sure the employee's "Scheduled
Start" and "Approver" properties are specified, and that their approver has a valid email
address in their employee profile.

Timesheet Due Notice

The Timesheet Due notice is sent to employees who have not submitted their timesheet by
a certain date. The date is relative to the end of the timesheet period, either before or after
it.

Timesheet Late Notice

Like the Timesheet Due Notice, the Timesheet Late notice is sent to employees who have
not submitted their timesheet by a certain date. The date is relative to the end of the
timesheet period, either before or after it. You can optionally CC the employee's approver(s)
using the CC property.

Timesheet Rejected Notice

The Timesheet Rejected notice is sent to employees immediately upon their timesheet being
rejected.

Timesheet Submitted Notice

The Timesheet Submitted notice is sent to the employee's approver when they submit their
timesheet.

Timesheet Approval Due Notice

The Timesheet Approval Due notice is sent to approvers who have timesheets waiting their
approval. This is sent at a date relative to the end of the timesheet period, and is only sent
to primary approvers, not backup approvers.

Timesheet Approval Late Notice

Like the Timesheet Approval Due notice, the Timesheet Approval Late notice is sent to
approvers who have timesheets waiting their approval. This is sent at a date relative to the
end of the timesheet period, and is only sent to primary approvers, not backup approvers.

Request Approval Due Notice

The Request Approval Due notice is sent to approvers who have requests waiting their
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approval. This is sent when a new request is created, and is only sent to primary approvers,
not backup approvers.

Request Approved Notice

The Request Approved notice is sent to request owners when their request is approved.

Request Rejected Notice

The Request Rejected notice is sent to request owners when their request is rejected.

Editing Notices

Administrators can edit the subject and body of the notices. The subject is plain text, but
the body can be either plain text or HTML. The body text can be up to 4000 characters. Both
the title and body can contain the following substitution variables:

Substitution Variables

Variable Description

${System.applicationName} Application Name, as specified in the Branding page.

${System.companyName} Company Name, as specified in the Branding page.

${System.url} Address of login page. This value is take from the
Application URL system property, which can be modified
on the System Settings page.

${System.currentDate} Current date

${System.currentDateTime} Current date and time

${System.currentTime} Current time

${TimeSheet.period} Timesheet period

${TimeSheet.rejectMessage} The timesheet rejection reason. This is only valid for the 
Timesheet Rejected notice.

${TimeSheet.url} Address of timesheet page

${TimeSheet.user.fullName} Timesheet owner's full name.

${User.fullName} Employee full name, which is the first name followed by
the last name.

${User.list} A list of employees. The list will depend on the type of
notice. For instance, in the Timesheet Approver Due
and Timesheet Approver Late notices this value will
resolve to the list of employees with timesheets that need
approving.

${User.login} Employee login name

${Request.user.fullName} Request owner's full name. This is valid only for Request
notices.

${Request.type} Request type, for example "Vacation". This is valid only
for Request notices.

${Request.date} Request date range. This is valid only for Request
notices.

${Request.finish} Request finish date and time (if specified). This is valid
only for Request notices.

${Request.rejectMessage} Request rejection message, in any. This is valid only for 
Request notices.
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${Request.approveMessage} Request approval message, if any. This is valid only for 
Request notices.

-o-
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Devices
Devices

Pacific Timesheet supports time and attendance tracking using hardware access devices,
such as models provided by ACTAtek (www.actatek.com).

The following devices are supported:

Manufacturer Model

ACTAtek
www.actatek.com

 PIN
 Smart Card
 Fingerprint
 Combination

Devices have the following properties:

Property Description

Name The device name, up to 80 characters. A value is required and
must be unique.

Description A description of the device, up to 255 characters.

Enabled This determines whether the device will be periodically (every
5 minutes or so) synchronized. Synchronization is where
device access logs are converted to employee timesheets.

IP Address The TCP/IP address of the device.

Secure Connection This option determines whether a secure or encrypted
connection is used when the Pacific Timesheet software
synchronizes with the device. For ACTAtek devices this means
SSL.

Login ID The administrator login ID for the device. For ACTAtek devices
this is case-sensitive.

Password The administrator login password. This is always
case-sensitive.

Last Synchronization The date and time Pacific Timesheet last successfully
synchronized with the device.

Adding Devices

1. The first step will be to install your access device and configure its IP address. If you are
using ACTAtek devices the ACTAtek Devices topic has more information.

2. Go to the System > Devices page and click the Add button. Fill in the name, address and
other settings as appropriate for the device. You can test the connection by clicking the
"Test Connection" button. When finished click the OK button.

3. If Pacific Timesheet can communicate successfully with the device you will see a status of
"Ready". If you see otherwise you will generally find the problem to be a network connection
issue (wrong IP address, no network connection, etc.). The first step to troubleshoot the
problem is to issue a "ping" command from a console on the machine running the Pacific
Timesheet software, for example "ping 192.168.0.100".

Synchronization



p98

© 2000-2007, Pacific Timesheet

Pacific Timesheet will read the access logs from each enabled device, usually about every 5
minutes. Access logs are records of each employee who punched in or out of the device. In
order for proper synchronization to work it is necessary for the employee's login ID for the
device match one of the following 3 employee properties in Pacific Timesheet :

1. The employee login name.
2. The employee ID.
3. The "Time Clock ID" custom employee field. If the login ID used for the time clock is not
appropriate for either the employee login or employee ID in Pacific Timesheet, then you can
create a custom text field named "Time Clock ID" (via the Employees tab > Manage Custom
Fields option). If this field is present then the device synchronization will try to match
against this field to find the appropriate Pacific Timesheet employee.

You can generally record a group ID with each access log entry. As for employees, each
group ID should have a corresponding group with the same name or ID in Pacific Timesheet
for proper synchronization.

Note: You can check for synchronization errors by viewing the synchronization log for each
device. From the System > Devices page click the name link to see the details of the
device. At the bottom of the page is the most recent synchronization messages.

-o-
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ACTAtek Devices
ACTAtek Devices

First Time Setup

Follow these steps to set up your ACTAtek device for the first time. If using multiple time
clocks please see the note at the end of this topic:

1. Connect the power and network cable to the device. The installation instructions that
came with the package cover this in detail.

2. Configure the IP address of the device. You will want to use a fixed (static) IP address.
Press the menu button on the device, which is the second button down from the top-right
corner of the keypad. You  will be prompted to log in - use the following values:

Login ID A999

Login Password 1

Press the arrow buttons on the bottom row of the keypad to move the selection to the "IP
Setting" menu, then press the enter button (the lower-right-most button on the keypad).
Then change the following values:

Subnet Mask The subnet mask, for example 255.255.255.0

DHCP Turn this off since we are using a fixed IP address

IP Address The TCP/IP address of this device, for example
192.168.0.100

Gateway The default gateway, for example 192.168.0.1

The network protocol used by the ACTAtek device is HTTP/HTTPS, so you may need to make
sure that those ports are allowed if any firewalls are between the device and the Pacific
Timesheet software.

The remaining setup steps will be performed from the device's web-based administration
interface.

3. Using a browser, enter the administration web page address for this device:

http://192.168.0.100

Replace the IP address above with the value appropriate for yours. Log in as the Super
Admin with the following values:

Login ID A999

Login Password 1

Login Level Super Administrator

Note that the login ID and password is case-sensitive (whereas for Pacific Timesheet only
the password is case-sensitive).

4. Click the Terminal Clock link on the navigation panel on the left side of the page. Set the
following values as appropriate:

Date The current date
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Time The current time

Time Zone The appropriate time zone for this device

Note: You have the option to use SNTP (Simple Network Time Protocol) to automatically
adjust the device's clock. This is not needed, however, as Pacific Timesheet will
automatically keep the device clock synchronized.

5. By default the ACTAtek device will record every access as an IN punch. This is useful if
you are using multiple devices and your employees may punch in on one device but out on
another. If you require your employees to punch in and out on the same device you should
set the device to record both IN and OUT punches. To do this click the "Terminal Setup" link
on the left side of the page, then enable the "Auto IN/OUT" setting.

Adding Employees

Employees (also called Users by the ACTAtek device) are generally best added at the device,
a necessity if using fingerprints. To add a new user to the device follow these steps:

1. Press the menu button on the device, which is the second button down from the top-right
corner of the keypad. You  will be prompted to log in - use the following values:

Login ID A999

Login Password 1

2. Choose the "Add User" menu and press the enter button (the lower-right-most button on
the keypad). Your options will include, depending upon the model, either fingerprint, smart
card or password. Choose the desired authentication method and press the enter key. You
will be asked for a user ID, which can be up to 20 characters (digits plus the letter A, B or
C). Enter the desired user ID and then follow the instructions for recording fingerprints,
smart card information or a password.

3. Using a browser, log into Pacific Timesheet and create an employee to match the one just
created on the device. Make sure either the employee's Login Name, Employee ID  or Time
Clock ID field matches the user ID entered on the device. The Time Clock ID field is an
optional custom field to use when you cannot use the login name or employee ID fields. To
create this, go to the Employees > Manage Custom Fields page and add a new text field
named "Time Clock ID".

Note: It is important that the Pacific Timesheet employee Login Name, Employee ID or
Time Clock ID field match the user ID on the device, otherwise the employee's timesheet
will not synchronize with the device.

Note: If you replace an old or defective device with a new one, you should also delete the
device entry from the list and re-add it. Otherwise you may find the system will not
synchronize with the new device.

Note: Using Multiple Time Clocks

When implementing multiple ACTAtek time clocks you have two major configuration
options:

1. Stand Alone Configuration (Default)

In this configuration each time clock acts as a stand-alone device. In this configuration,
each clock must be individually configured, with users enrolled at each device. Each device
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must be added to Pacific Timesheet for synchronization.

2. Primary/Secondary Configuration

In this configuration you define one of your time clocks as the primary device. Then every
other device is defined as a secondary and configured to synchronize with the primary
device. In this configuration you only need to configure and enroll users at the primary
device. Only the primary device must be added to Pacific Timesheet for synchronization.

Note: Do not add secondary devices to Pacific Timesheet for synchronization or you will get
duplicate timesheet data.

See the Primary/Secondary option under 'Terminal Settings' in the ACTAtek web
administrative interface for more details.

Note: Resetting the Super Admin (A999) Password

For security reasons, there is no way to manually reset the device back to its factory
settings or otherwise reset the Super Admin (A999) password. If you have forgotten your
Super Admin password please do the following:

1. Email the serial number and IP address of the unit to support@actatek.com, letting them
know you want to reset the Super Admin password. To get the serial number and IP address
press the Enter button on the ACTAtek unit six times and it will display the information.

2. You will be emailed a link to a password recovery patch, which will, for security, expire
after 48 hours. Download this patch to your local computer.

3. Open a browser on your local computer and go to the recovery page of the ACTAtek unit,
as described in the email response from ACTAtek. For instance:

    http://192.168.1.88/cgi-bin/recovery.cgi

4. Upload the recovery patch as per the instructions on this page. Once the upload is
completed you will be able to log in as the Super Admin: A999 with password 1.

-o-
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Schema (Self-Hosted Version Only)
Schema

A schema is a set of database tables, and is used by the application to store timesheet data
and settings. If you are hosting the application yourself you can review your schema
settings, as well as edit or create a new schema. Normally you would use the schema
created by the installer and never change these settings. But if you would like to use an
external database like Microsoft SQL Server or Oracle, or if you installed the WAR version of
the application, you will need to create a new schema before you can use the system. 

Note: For security reasons you may only access the Schema page if you are on the
computer running the timesheet service.

For a list of supported databases and versions refer to the System Requirements topic. The
installer provides the following database:

Bundled Database

MySQL 5.0.22 Default TCP/IP Port: 3316
Administrative Login: See the "Bundled Software" section in
timesheet-install.pdf

The Schema page is located at the following address:

http://localhost/timesheet/system/db-show.do

If you changed the default HTTP port from 80 then you will need to specify the port number,
too, for example:

http://localhost:8080/timesheet/system/db-show.do

This will load a page showing the current schema configuration. You can edit this schema
configuration by clicking the Edit button, or create a new schema by clicking the Create
button. Note that for security reasons you need to be using a browser on the same machine
that the application is installed on.

Editing the schema configuration will not alter the schema, just the settings that the
application uses to connect to the schema. Creating a new schema will not delete or alter
the old schema, but will create a new schema and update the settings so that the
application will use the new one.

Schema Properties

Database Type

The type of database management system (DBMS) to be used. The following types are
supported:

Server Address

The TCP/IP address or host name of the database server. Use localhost if the database
server is running on the same computer as the application.

Server Port

The TCP/IP port number used by the database server. The value will default to the number
appropriate for the database type, which is generally the value you want to use.
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Schema Name/Oracle SID

For Microsoft and MySQL the schema name is the name of the database. For Oracle you
would use the SID (Server IDentifier).

Login Name

The login name for the database account to use when connecting to the database server.

Password

The password for the login.

When creating a new schema you have the following additional properties:

Admin Login

The login name for the administrative account for the database server. Note that if creating
a new schema or database using the bundled MySQL database, the default administrative
login is root with the password is timesheet.

Admin Password

The password for the administrative account. Note that if creating a new schema or
database using the bundled MySQL database, the default administrative login is root with
the password is timesheet.

New Schema Name

For Microsoft and MySQL this is the name of the new database to create. For Oracle this is
the name of the new tablespace to create.

New Login

The login name for the new database account to use when connecting to the database
server.

New Password

The password for the new login.

SQL Server 2005 Note: SQL Server 2005 has stricter login and password rules than SQL
Server 2000 by default. Make sure the password for the new database schema doesn’t
match the new schema name, as this will often cause an error. You can see details for the
error message in the log files, located in the tomcat/logs directory of the installation
directory.

-o-
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Custom Fields
Custom Fields

You can customize many objects in the application by adding new data fields. Custom fields
allows you to store additional information with an object, such as a text string, a date, a file
attachment or any other value as needed for your business-specific requirements. You can
manage custom fields for objects from the "Manage Custom Fields" link on the options menu
on the page that lists the objects. For instance, to manage Employee custom fields you go
to the Employees page, click the options menu (the small triangle to the top-right of the
employee list) and choose "Manage Custom Fields". If you do not see this you may not have
management permissions for this type of object - check your Permission Level in your
employee profile to verify that you have the appropriate permissions.

Once created, custom field values can be set through the web interface for each object, or
imported/exported. You can create reports that include the custom fields as well. 

Note: If you create a report with a custom field, then later delete the custom field, the
report will generate an error when run. This is because the database column is now
missing. To correct this simply edit the report and remove the obsolete report column in
order for the report to run correctly again.

Custom fields have the following properties:

General Properties

Field Name

The name of the custom field. This is the name that will appear on the properties form, as
well as in import/export files. This field is required and can be up to 80 characters.

Type

The type of custom field, which can be one of the following:

Type Description

Checkbox A field representing a true/false choice.

Currency A number representing a currency amount.

Date A date value.

Date and Time A date and time value.

Email Address A text field for entering and displaying an email
address.

Employee An employee selection.

File Attachment Allows uploading and downloading of a file. Maximum
size is limited to 250MB.

Image Allows uploading and displaying of an image. Maximum
size is limited to 250MB.

List A text field allowing the selection of one or more
choices from a list of choices.

Number A numeric value, allowing an arbitrary number of
decimal places of precision.

Text A text value.

Text Area A text value that allows line breaks.
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Time A time of day value.

Web Link A text field for entering and displaying a web address.

You can only specify the type when adding a new custom field. If you need to change the
type of an existing custom field you need to delete the existing one and create a new one.

Position

The position determines where on the form the field will appear.

Start New Field Group

Checking this option will cause a horizontal line to appear immediately before this field. This
is useful when grouping several related fields.

Description

A description of this field. This should be as brief as possible, but can be up to 255
characters.

Required

Checking this option will require a value for this field.

Checkbox Properties

Default Value

Specifies the default check state.

Checkbox Text

Text or label that appears to the right of the checkbox. This should be as terse as possible,
but can be up to 80 characters.

Currency Properties

Currency

The currency symbol.

Decimal Digits

The number of digits to display after the decimal point. This can be zero if displaying an
integer value.

Minimum Value

The minimum value this field can have. Leave this blank if there is no minimum value.

Maximum Value

The maximum value this field can have. Leave this blank if there is no maximum value.

Image

Width
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Specify this value if you want to scale the image to this width, in pixels.

Height

Specify this value if you want to scale the image to this height, in pixels.

List

List Style

The style of the list control, which can be either a drop-down menu or a list box.

List Box Height

The height of the list box, in rows.

Multiple Selection

Checking this option allows multiple selections. Note that multiple selections are stored in
same field just like single selections, but with each selection being separated by a line break
character.

List Choices

Enter your list choices here, with each choice starting on a new line.

Number

Decimal Digits

The number of digits to display after the decimal point. This can be zero if displaying an
integer value.

Minimum Value

The minimum value this field can have. Leave this blank if there is no minimum value.

Maximum Value

The maximum value this field can have. Leave this blank if there is no maximum value.

Text

Maximum Characters

The maximum number of characters that can be entered in this field. This can be up to 255
characters.

Text Area

Maximum Characters

The maximum number of characters that can be entered in this field. This can be up to
4000 characters.

Rows

The height of the text area, in rows.
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Importing/Exporting
Importing/Exporting

You can import and export objects such as employees, groups and tasks in CSV (Comma
Separated Value) format. Note that your ability to import or export will depend upon your
permission level: administrators can import and export any object but other permission
levels may have the ability to import or export disabled.

CSV Formatting Notes

In order to make data interchange as reliable as possible, the following formatting rules are
followed:

 Dates, times and numbers are formatted for the locale of the user doing the
import/export.

 Unicode (UTF8) character encoding is used in order to fully support international
languages. Make sure you save your CSV files in UTF8 format in order to not lose
accented characters, etc. Exported CSV data is always generated in UTF8 format.

 Field values with commas or carriage returns are 'escaped' by enclosing the value in
double-quotes.

 Fields with multiple values have each value separated by a carriage return (also called a
"hard" carriage return in Excel, entered using ALT+ENTER). When importing data you
can optionally use a semicolon character instead, if you prefer.

In addition:

 All fields are optional unless otherwise noted.
 The behavior of blank values depends on the field.
 A header record at the start of the file is required.

Match Field

When importing some types of objects you can specify a match field, which is used to avoid
creating duplicates. The match field determine which property is used to match against
existing objects to avoid duplicates. For instance, when importing employees you generally
you would use the Login Name, but the Employee ID and Email are also options.

Objects

The following objects can be imported and exported in CSV format - c lick the links for a
detailed description of the CSV fields:

 Bill Rates
 Timesheets
 Employees
 Employee Balances
 Groups
 Customers
 Pay Rates
 Project Groups
 Projects
 Task Groups
 Tasks

http://en.wikipedia.org/wiki/Comma-separated_values
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Bill Rates CSV Format
Bill Rates Fields

Field Description Format

Object The name of primary object that rates
depend on, for example "Employee". This is
optional if the Object ID field is supplied.

Text (80 chars max)

Object ID The ID of the primary object the rates
depend on, for example "222-99-5555".
This is optional if the Object field is
supplied.

Text (80 chars max)

Subobject The name of exceptioin object that rates
depend on, for example "Group". This is
optional if the Subobject ID field is
supplied. The subobject or subobject ID is
optional if you are setting the default rate
for the object.

Text (80 chars max)

Subobject ID The ID of the exception object the rates
depend on, for example "Accounting
Group". This is optional if the Subobject
field is supplied. The subobject or subobject
ID is optional if you are setting the default
rate for the object.

Text (80 chars max)

Bill Rate The rate for this object/subobject. The rate
can be either a numeric value, or the name
of a rate as defined in the System > Bill
Rate Options page.

Number/Text

-o-
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Timesheet CSV Format
Timesheet Fields

Timesheet data can be both exported and imported. The following fields are supported:

Field Description Format

Employee Employee login name. This or Employee.ID
is required when importing.

Text

Employee.ID Employee ID. This or Employee is required
when importing.

Text

Employee.Ty
pe

The type of employee, for example
Non-exempt or Exempt.

Text

Start Time entry start date and time. Required. Date-Time

Finish Time entry finish date and time. This or
Hours is required if adding a new time
entry.

Date-Time

Hours Time entry hours. This or Finish is required
if adding a new time entry.

Number

Type Time entry type, either Work or Leave. Text

Work Work hours. Number

Leave Leave hours. Number

Pay Code Pay code name or ID. Text

Pay Code.ID Pay code ID. Text

Reporting
Group

Reporting group name. Text

Reporting
Group.ID

Reporting group ID. Text

Customer Customer name. Text

Customer.ID Customer ID. Text

Project
Group

Project group name. Text

Project
Group.ID

Project group ID. Text

Project Project name. Text

Project.ID Project ID. Text

Task Group Task group name. Text

Task
Group.ID

Task group ID. Text

Task Task name. Text

Task.ID Task ID. Text

Bill Rate Bill rate for this time entry. Number

Bill Amount Bill amount for this time entry, which is Bill
Rate x Hours.

Number

Pay Rate Pay rate for this time entry. Number

Pay Amount Pay amount for this time entry, which is
Pay Rate x Hours.

Number

Notes Time entry notes. Text (2000 chars max)
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Regular
Time

Regular time hours. Number

Over Time Over time hours. Number

Double Time Double time hours. Number

Flex Time Flex-time hours. Number

Submitted Indicates whether this time entry has been
submitted (locked). Possible values are Yes
or No.

Text

Submit Date The date this time entry was submitted. Date

Submitted
By

Who submitted this time entry. Text

Approved Indicates whether this time entry has been
approved. Possible values are Yes or No.

Text

Approval
Date

The date this time entry was approved. Date

Approved By Who approved this time entry. Approver

Rejected Indicates whether this time entry has been
rejected by an approver. Possible values
are Yes or No.

Text

Reject Date The date this time entry was rejected. Date

Rejected By Who rejected this time entry. Text

Importing Timesheets

Importing timesheets is something we usually like to help customers with as it requires
careful planning, including backing up the database beforehand so you can revert it if for
some reason the data is wrong. Typically, to get started, you would export a representative
set of timesheets and save it as a CSV file (from the Timesheets tab), then trim out the
unneeded columns. This can then be used as a template. Here are some important things to
know about the import data format:

1. You can use either the name of objects (e.g. the employee login name, the group name,
etc.), or the ID of the object, e.g. the employee id or the group id. 

2. At a minimum, you'll want the Employee (login name), Start and Hours columns. The
Start field needs the time of day if there is more than one time entry for a single day. This
is because the timesheet import will try to update an existing time entry, so if you have two
records for the same employee with the same start, the second one will just update the first
one. This avoids the danger of accidentally reimporting the same file twice and getting
duplicate time entries.

3. The date, time and number formats are in the locale of the person doing the import. Also,
the Start etc. fields are assumed to be in the time zone of the person doing the import. So if
you are importing data for people in time zones scattered around the globe you might have
to make some adjustments.

4. For time off or leave, you'll want to specify the appropriate pay code name or pay code
ID.

5. To mark the timesheet as locked or submitted, add the Submitted field or column, and
specify Yes for each timesheet entry. 
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Employee CSV Format
Employee Fields

Field Description Format

Login Name Employee login name. If this field is present in the CSV data then
a value is required, and is always required when adding new
employees.

Text (80
chars
max)

Password Employee password. This field is not exported but can be
imported. Updating an employee's password through an import
creates an expired password - the employee will be asked to
enter a new one the next time they log in.

Text (40
chars
max)

First Name First name. Text (80
chars
max)

Last Name Last name. If this field is present in the CSV data then a value is
required, and is always required when adding new employees.

Text (80
chars
max)

ID Employee ID. This field is not required, but if present and the
value is not blank then it must be unique for all employees.

Text (80
chars
max)

Status Employee status. Possible value are:
Value Description
Active Employee can log into system.
Inactive Employee cannot log into system, and does not show

up on reports, etc. by default.
Locked Employee cannot log into system, but shows up on

reports, etc. by default. An employee can become
locked due to too many unsuccessful login attempts.

Text

Permission
Level

The default permission level, for example Employee. Text

Employee
Type

The type of employee. Text

Policy The policy for this employee. Text

Job Title Job title. Text (80
chars
max)

Reporting
Group

The name of the primary or reporting group. Text

First Day The first day of employment. Date

Last Day The last day of employment. Date

Scheduled
Hours

The number of hours the employee is scheduled to work each
week.

Number

Scheduled
Start

The time of day the employee is scheduled to start work or
"punch in".

Time

Scheduled
Finish

The time of day the employee is scheduled to finish work or
"punch out".

Time

Email Email address. Text (80
chars
max)
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Phone Phone number. Text (40
chars
max)

Mobile Mobile phone number. Text (40
chars
max)

Fax Fax number. Text (40
chars
max)

Timesheet
Template

The timesheet template for this employee. Text

Timesheet
Memory

This controls whether rows and hours are carried forward from
the previous timesheet to new timesheets. Possible values are:
Value Description
None None (or a blank value) indicates no

rows or hours will be carried forward.
Rows Timesheet rows will be carried forward

from previous timesheet.
Rows and Hours Timesheet rows and hours will be

carried forward from previous
timesheet.

Text

Punched In A "Yes"/"No" value indicating whether the employee is punched in
or not. This is a read-only value and will be ignored if imported.

Text

Locale Locale. The locale determines how dates and numbers are
formatted. Locale are specified using ISO codes, and possible
values are defined in the Locale Codes appendix.

Text (5
chars
max)

Time Zone Time zone. Time zones are specified using Olson IDs, and possible
values are defined in the Time Zone Codes appendix.

Text (40
chars
max)

Bill Rate The default bill rate. This can be a named rate, or a custom
numeric value.

Text or
Number

Pay Rate The default pay rate. This can be a named rate, or a custom
numeric value.

Text or
Number

Groups The list of groups this employee is a member of. If a user belongs
to multiple groups then each group is separated by a carriage
return. If formatting an import file using Excel you can enter
multiple lines in a cell using ALT+ENTER (also called a "hard"
carriage return). 

Text

Notes Notes about this employee. Text
(2000
chars
max)

Approver The name of the primary timesheet approver for the employee.
The name can be a login name, employee ID, or full name (either
"first last" or "last, first" is accepted).

Text

Approver
Backup

The name of the backup timesheet approver for the employee.
The name can be in the form of a login name, employee ID, or
full name (either "first last" or "last, first" is accepted).

Text

-o-
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Employee Balances CSV Format
Employee Balances Fields

Field Description Format

Employee Employee login name. Either this field or
Employee ID must be specified when
importing.

Text (80 chars max)

Employee ID Employee ID. Either this field or Employee
must be specified when importing.

Text (80 chars max)

Balance Balance name. Either this field or Balance
ID must be specified when importing.

Text (80 chars max)

Balance ID Balance ID. Either this field or Balance
must be specified when importing.

Text (80 chars max)

Date When importing this is the date the Value
or Change should take effect. When
exporting this is the current date.

Date

Value The value of the balance, in hours. When
importing the balance will be set to this
value as of the specified Date. This field is
ignored when importing if Change is
specified. When exporting this is the
current balance.

Number

Change The number of hours to add or deduct from
the balance for the specified Date. This field
overrides any value in the Value field when
importing. This field is only applicable when
importing.

Number

Comment A comment about this change. This field is
only applicable when importing.

Text (255 chars max)

-o-
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Group CSV Format
Group Fields

Field Description Format

Name Group name. If this field is present in the CSV data then a value
is required, and is always required when adding new groups.

Text (80 chars
max)

ID Group ID. This field is not required, but if present and the value is
not blank then it must be unique for all groups.

Text (80 chars
max)

Descri
ption

A description of this group. Text (255 chars
max)

Status Group status. Possible value are:
Value Description
Active Employee can log into system.
Inactive Employee cannot log into system, and does not show

up on reports, etc. by default.

Text

Emplo
yees

The list of employees that are members of this group. Multiple
employees have each value separated by a carriage return (also
called a "hard" carriage return in Excel, entered using
ALT+ENTER). The names can be in the form of a login name,
employee ID, or full name (either "first last" or "last, first" is
accepted).

Text

Permis
sions

The list of employees and groups given special permission on this
object. Multiple permissions have each value separated by a
carriage return (also called a "hard" carriage return in Excel,
entered using ALT+ENTER). Each value is of the form:

Object Name=Permission Level (Object Type)

Where Object Name is the name of the group or the login of the
employee, Permission Level is the permission level to give the
employee or group on this object, and Object Type is the whether
this is an Employee or Group that is being given permission. Here
is an example of a group and an employee assigned to an object:

GroupA=Timekeeper (Group)
jmeyers=Manager (Employee)

Note that the permission level and object type are optional. If the
permission level is not specified then it will be set to the
employee's default permission level. If the object type is not
specified the system will first check for a group with a matching
name, then look for an employee with a matching login name.
Only if you have group names and employee logins that might be
the same do you need to specify the object type.

Text

Notes Notes about this group. Text (2000
chars max)

-o-
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Customer CSV Format
Customer Fields

Field Description Format

Name Customer name. If this field is present in the CSV data then a
value is required, and is always required when adding new
customers.

Text (80 chars
max)

ID Customer ID. This field is not required, but if present and the
value is not blank then it must be unique for all customers.

Text (80 chars
max)

Descri
ption

A description of this customer. Text (255 chars
max)

Status Customer status. Possible value are:
Value Description
Active Employee can log into system.
Inactive Employee cannot log into system, and does not show

up on reports, etc. by default.

Text

Permis
sions

The list of employees and groups given special permission on this
object. Multiple permissions have each value separated by a
carriage return (also called a "hard" carriage return in Excel,
entered using ALT+ENTER). Each value is of the form:

Object Name=Permission Level (Object Type)

Where Object Name is the name of the group or the login of the
employee, Permission Level is the permission level to give the
employee or group on this object, and Object Type is the whether
this is an Employee or Group that is being given permission. Here
is an example of a group and an employee assigned to an object:

GroupA=Timekeeper (Group)
jmeyers=Manager (Employee)

Note that the permission level and object type are optional. If the
permission level is not specified then it will be set to the
employee's default permission level. If the object type is not
specified the system will first check for a group with a matching
name, then look for an employee with a matching login name.
Only if you have group names and employee logins that might be
the same do you need to specify the object type.

Text

Notes Notes about this customer. Text (2000
chars max)

-o-
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Pay Rates CSV Format
Pay Rates Fields

Field Description Format

Object The name of primary object that rates
depend on, for example "Employee". This is
optional if the Object ID field is supplied.

Text (80 chars max)

Object ID The ID of the primary object the rates
depend on, for example "222-99-5555".
This is optional if the Object field is
supplied.

Text (80 chars max)

Subobject The name of exceptioin object that rates
depend on, for example "Group". This is
optional if the Subobject ID field is
supplied. The subobject or subobject ID is
optional if you are setting the default rate
for the object.

Text (80 chars max)

Subobject ID The ID of the exception object the rates
depend on, for example "Accounting
Group". This is optional if the Subobject
field is supplied. The subobject or subobject
ID is optional if you are setting the default
rate for the object.

Text (80 chars max)

Pay Rate The rate for this object/subobject. The rate
can be either a numeric value, or the name
of a rate as defined in the System >  Pay
Rate Options page.

Number/Text

-o-
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Project Group CSV Format
Project Group Fields

Field Description Format

Name Project Group name. If this field is present in the CSV data then a
value is required, and is always required when adding new project
groups.

Text (80 chars
max)

ID Project Group ID. This field is not required, but if present and the
value is not blank then it must be unique for all project groups.

Text (80 chars
max)

Descri
ption

A description of this project group. Text (255 chars
max)

Status Project Group status. Possible value are:
Value Description
Active Employee can log into system.
Inactive Employee cannot log into system, and does not show

up on reports, etc. by default.

Text

Permis
sions

The list of employees and groups given special permission on this
object. Multiple permissions have each value separated by a
carriage return (also called a "hard" carriage return in Excel,
entered using ALT+ENTER). Each value is of the form:

Object Name=Permission Level (Object Type)

Where Object Name is the name of the group or the login of the
employee, Permission Level is the permission level to give the
employee or group on this object, and Object Type is the whether
this is an Employee or Group that is being given permission. Here
is an example of a group and an employee assigned to an object:

GroupA=Timekeeper (Group)
jmeyers=Manager (Employee)

Note that the permission level and object type are optional. If the
permission level is not specified then it will be set to the
employee's default permission level. If the object type is not
specified the system will first check for a group with a matching
name, then look for an employee with a matching login name.
Only if you have group names and employee logins that might be
the same do you need to specify the object type.

Text

Notes Notes about this project group. Text (2000
chars max)

-o-
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Project CSV Format
Project Fields

Field Description Format

Name Project name. If this field is present in the CSV data then a value
is required, and is always required when adding new projects.

Text (80 chars
max)

ID Project ID. This field is not required, but if present and the value
is not blank then it must be unique for all projects.

Text (80 chars
max)

Descript
ion

A description of this project. Text (255
chars max)

Status Project status. Possible value are:
Value Description
Active Employee can log into system.
Inactive Employee cannot log into system, and does not show

up on reports, etc. by default.

Text

Planned
Start
Date

Planned project start date. Date

Planned
Finished
Date

Planned project finish or end date. Date

Planned
Estimat
ed Work

Planned number of hours to complete this project. Number

Actual
Start
Date

Actual project start date. Date

Actual
Finished
Date

Actual project finish or end date. Date

Permissi
ons

The list of employees and groups given special permission on this
object. Multiple permissions have each value separated by a
carriage return (also called a "hard" carriage return in Excel,
entered using ALT+ENTER). Each value is of the form:

Object Name=Permission Level (Object Type)

Where Object Name is the name of the group or the login of the
employee, Permission Level is the permission level to give the
employee or group on this object, and Object Type is the whether
this is an Employee or Group that is being given permission. Here
is an example of a group and an employee assigned to an object:

GroupA=Timekeeper (Group)
jmeyers=Manager (Employee)

Note that the permission level and object type are optional. If the
permission level is not specified then it will be set to the
employee's default permission level. If the object type is not
specified the system will first check for a group with a matching
name, then look for an employee with a matching login name.
Only if you have group names and employee logins that might be
the same do you need to specify the object type.

Text
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Notes Notes about this project. Text (2000
chars max)
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Task Group CSV Format
Task Group Fields

Field Description Format

Name Task Group name. If this field is present in the CSV data then a
value is required, and is always required when adding new task
groups.

Text (80 chars
max)

ID Task Group ID. This field is not required, but if present and the
value is not blank then it must be unique for all task groups.

Text (80 chars
max)

Descri
ption

A description of this task group. Text (255 chars
max)

Status Task Group status. Possible value are:
Value Description
Active Employee can log into system.
Inactive Employee cannot log into system, and does not show

up on reports, etc. by default.

Text

Permis
sions

The list of employees and groups given special permission on this
object. Multiple permissions have each value separated by a
carriage return (also called a "hard" carriage return in Excel,
entered using ALT+ENTER). Each value is of the form:

Object Name=Permission Level (Object Type)

Where Object Name is the name of the group or the login of the
employee, Permission Level is the permission level to give the
employee or group on this object, and Object Type is the whether
this is an Employee or Group that is being given permission. Here
is an example of a group and an employee assigned to an object:

GroupA=Timekeeper (Group)
jmeyers=Manager (Employee)

Note that the permission level and object type are optional. If the
permission level is not specified then it will be set to the
employee's default permission level. If the object type is not
specified the system will first check for a group with a matching
name, then look for an employee with a matching login name.
Only if you have group names and employee logins that might be
the same do you need to specify the object type.

Text

Notes Notes about this task group. Text (2000
chars max)

-o-
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Task CSV Format
Task Fields

Field Description Format

Name Task name. If this field is present in the CSV data then a value is
required, and is always required when adding new tasks.

Text (80 chars
max)

ID Task ID. This field is not required, but if present and the value is
not blank then it must be unique for all tasks.

Text (80 chars
max)

Descript
ion

A description of this task. Text (255
chars max)

Status Task status. Possible value are:
Value Description
Active Employee can log into system.
Inactive Employee cannot log into system, and does not show

up on reports, etc. by default.

Text

Planned
Start
Date

Planned project start date. Date

Planned
Finished
Date

Planned project finish or end date. Date

Planned
Estimat
ed
Work

Planned number of hours to complete this project. Number

Actual
Start
Date

Actual project start date. Date

Actual
Finished
Date

Actual project finish or end date. Date
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Permiss
ions

The list of employees and groups given special permission on this
object. Multiple permissions have each value separated by a
carriage return (also called a "hard" carriage return in Excel,
entered using ALT+ENTER). Each value is of the form:

Object Name=Permission Level (Object Type)

Where Object Name is the name of the group or the login of the
employee, Permission Level is the permission level to give the
employee or group on this object, and Object Type is the whether
this is an Employee or Group that is being given permission. Here
is an example of a group and an employee assigned to an object:

GroupA=Timekeeper (Group)
jmeyers=Manager (Employee)

Note that the permission level and object type are optional. If the
permission level is not specified then it will be set to the
employee's default permission level. If the object type is not
specified the system will first check for a group with a matching
name, then look for an employee with a matching login name.
Only if you have group names and employee logins that might be
the same do you need to specify the object type.

Text

Notes Notes about this task. Text (2000
chars max)

-o-
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REST API
REST API

Overview

REST stands for Representational State Transfer, and is a very convenient API (Application
Programming Interface) for interacting with Pacific Timesheet web services. More
information about REST can be found here.

To use the REST API you send simple HTTP GET or POST requests to the base address of
your Pacific Timesheet server, for example
http://someco.pacifictimesheet.com/timesheet/rest. Each API method call is a simple URL
that you append to the base address. Each argument is either provided as a query string
parameter or a post request parameter. So for instance, the following method call on an
object:

object.method(argument1=value1, argument2=value2)

translates to:

http://someco.pacifictimesheet.com/timesheet/rest/object/method?argument1=value1&ar
gument2=value2 

Encoding

Data sent and received is encoded according to the following rules:

 All parameters sent to the server must be URL-encoded. For instance, spaces should be
replaced with the "+" character, etc. 

 The character encoding is always UTF-8. 
 Dates and numbers are formatted in the locale of the authenticated user.

Authentication

Most actions require an authenticated user account. There are two ways to do this:

 You log in and start an authentication session 
 You perform one-shot operations and authenticate through a submission at each

request 

Logging In (Session Handling)

When you log in beforehand, you'll receive a unique authentication identifier that you can
later use as a token to prove that you have already authenticated. You provide this token as
a value of the jsessionid argument. For instance:

http://someco.pacifictimesheet.com/timesheet/rest/group/get;jsessionid=A5E8D15765A42
A4EF82254A05E35D243?name=Administrative+Employees

If your client supports it, a jsessionid cookie will also be created. In that case, you don't
have to provide the argument to every method call. The cookie will be sent automatically
and Pacific Timesheet will use it. For security, authenticated sessions will expire
automatically after 20 minutes of inactivity.

One-Shot Operations

http://rest.blueoxen.net/cgi-bin/wiki.pl?FrontPage
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You can authenticate any submission by including the auth-login and auth-password
arguments to the request. For instance:

http://someco.pacifictimesheet.com/timesheet/rest/group/get?name=Administrative+Emplo
yees&auth-login=admin&auth-password=12345

Error Reporting

When errors occur during the execution of the method and the submission, the status
attribute of the response tag will be set to "fail", and the message attribute will contain a
description of the error. This is an example of a possible errors response:

<response status="fail" message="No group found with name &quot;Administrative
Employees&quot;"/>

Note that the double quote and single quote characters in attributes will be escaped with
their XML entities, &quot; and &apos;, respectively.

Supported Methods

Session Object
connect
disconnect

User Object
add
delete
get
update

Group Object
add
delete
get
update

Customer Object
add
delete
get
update

Project Group Object
add
delete
get
update

Project Object
add
delete
get
update

Task Group Object
add
delete
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get
update

Task Object
add
delete
get
update

Time Entry Object
add
delete
get
update

-o-
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Customer.Add
Customer.Add

Adds a new customer.

Note: The term customer may have been renamed in your system using the terminology
feature. For instance, in the System > General > Terminology page customers may have
been renamed to clients. You still use the object name 'customer', however, when using
the REST API. The name of the objects in the REST API never change.

URL

/timesheet/rest/customer/add

Parameters

Field Description Format

name Customer name. Always required when adding new customers. Text (80
chars max)

uid Customer ID. This field is not required, but if present and the
value is not blank then it must be unique for all customers.

Text (80
chars max)

descriptio
n

A description of this customer. Text (255
chars max)

status Customer status. Possible value are:
Value Description
Active Employee can log into system.
Inactive Employee cannot log into system, and does not show

up on reports, etc. by default.

Text

acls The list of employees and groups given special permission on this
object. Multiple permissions have each value separated by a
carriage return (also called a "hard" carriage return in Excel,
entered using ALT+ENTER). Each value is of the form:

Object Name=Permission Level (Object Type)

Where Object Name is the name of the group or the login of the
employee, Permission Level is the permission level to give the
employee or group on this object, and Object Type is the whether
this is an Employee or Group that is being given permission. Here
is an example of a group and an employee assigned to an object:

GroupA=Timekeeper (Group)
jmeyers=Manager (Employee)

Note that the permission level and object type are optional. If the
permission level is not specified then it will be set to the
employee's default permission level. If the object type is not
specified the system will first check for a group with a matching
name, then look for an employee with a matching login name.
Only if you have group names and employee logins that might be
the same do you need to specify the object type.

Text

notes Notes about this customer. Text (2000
chars max)
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Example Request

http://someco.pacifictimesheet.com/timesheet/rest/customer/add?name=Administrative+
Employees 

Example Result

<?xml version="1.0" encoding="UTF-8" ?>
<response status="ok">
    <customer id="3231"/>
</response>

-o-
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Customer.Delete
Customer.Delete

Deletes a particular customer.

Note: The term customer may have been renamed in your system using the terminology
feature. For instance, in the System > General > Terminology page customers may have
been renamed to clients. You still use the object name 'customer', however, when using
the REST API. The name of the objects in the REST API never change.

URL

/timesheet/rest/customer/delete

Parameters

Parameter Description Format

id The object ID, a unique, persistent identifier
generated by Pacific Timesheet. If this is specified
then do not specify the name or uid parameters.

Integer

name The customer name. If this is specified then do not
specify the id or uid parameters.

Text

uid The customer ID. If this is specified then do not
specify the id or name parameters.

Text

Example Request

http://someco.pacifictimesheet.com/timesheet/rest/customer/delete?name=Administrative
+Employees 

Example Result

<?xml version="1.0" encoding="UTF-8" ?>
<response status="ok">
    <customer/>
</response>

-o-
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Customer.Get
Customer.Get

Retrieves a particular customer.

Note: The term customer may have been renamed in your system using the terminology
feature. For instance, in the System > General > Terminology page customers may have
been renamed to clients. You still use the object name 'customer', however, when using
the REST API. The name of the objects in the REST API never change.

URL

/timesheet/rest/customer/get

Parameters

Parameter Description Format

id The object ID, a unique, persistent identifier
generated by Pacific Timesheet. If this is specified
then do not specify the name or uid parameters.

Integer

name The customer name. If this is specified then do not
specify the id or uid parameters.

Text

uid The customer ID. If this is specified then do not
specify the id or name parameters.

Text

Example Request

http://someco.pacifictimesheet.com/timesheet/rest/customer/get?name=Administrative+E
mployees 

Example Result

<?xml version="1.0" encoding="UTF-8" ?>
<response status="ok">
    <customer id="3231" 
        name="Excelsior Projecct" 
        uid="P-1001" 
        description="25 nm process" 
        status="Active" 
        notes=""/>
</response>

-o-
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Customer.Update
Customer.Update

Updates the properties of a particular customer.

Note: The term customer may have been renamed in your system using the terminology
feature. For instance, in the System > General > Terminology page customers may have
been renamed to clients. You still use the object name 'customer', however, when using
the REST API. The name of the objects in the REST API never change.

URL

/timesheet/rest/customer/update

Parameters

To identify the customer to be updated Pacific Timesheet looks for the following parameters
in the request:

Parameter Description Format

id The object ID, a unique, persistent identifier
generated by Pacific Timesheet.

Integer

name The customer name. Text

uid The customer ID. Text

If more than one of the above are specified then the customer will be identified by using the
parameter in the order specified above: id, name then uid. 

In addition to the above parameters, all of the parameters defined in Customer.Add are
supported.

Example Request

http://someco.pacifictimesheet.com/timesheet/rest/customer/update?name=Administrativ
e+Employees&status=Inactive 

Example Result

<?xml version="1.0" encoding="UTF-8" ?>
<response status="ok">
    <customer id="3231"/>
</response>

-o-
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Group.Add
Group.Add

Adds a new group.

URL

/timesheet/rest/group/add

Parameters

Field Description Format

name Group name. Always required when adding new groups. Text (80
chars max)

uid Group ID. This field is not required, but if present and the value is
not blank then it must be unique for all groups.

Text (80
chars max)

descriptio
n

A description of this group. Text (255
chars max)

status Group status. Possible value are:
Value Description
Active Employee can log into system.
Inactive Employee cannot log into system, and does not show

up on reports, etc. by default.

Text

userids The list of employees that are members of this group. Multiple
employees have each value separated by a carriage return (also
called a "hard" carriage return in Excel, entered using
ALT+ENTER).

Text

acls The list of employees and groups given special permission on this
object. Multiple permissions have each value separated by a
carriage return (also called a "hard" carriage return in Excel,
entered using ALT+ENTER). Each value is of the form:

Object Name=Permission Level (Object Type)

Where Object Name is the name of the group or the login of the
employee, Permission Level is the permission level to give the
employee or group on this object, and Object Type is the whether
this is an Employee or Group that is being given permission. Here
is an example of a group and an employee assigned to an object:

GroupA=Timekeeper (Group)
jmeyers=Manager (Employee)

Note that the permission level and object type are optional. If the
permission level is not specified then it will be set to the
employee's default permission level. If the object type is not
specified the system will first check for a group with a matching
name, then look for an employee with a matching login name.
Only if you have group names and employee logins that might be
the same do you need to specify the object type.

Text

notes Notes about this group. Text (2000
chars max)
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Example Request

http://someco.pacifictimesheet.com/timesheet/rest/group/add?name=Administrative+Emp
loyees 

Example Result

<?xml version="1.0" encoding="UTF-8" ?>
<response status="ok">
    <group id="3231"/>
</response>

-o-
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Group.Delete
Group.Delete

Deletes a particular group.

URL

/timesheet/rest/group/delete

Parameters

Parameter Description Format

id The object ID, a unique, persistent identifier
generated by Pacific Timesheet. If this is specified
then do not specify the name or uid parameters.

Integer

name The group name. If this is specified then do not
specify the id or uid parameters.

Text

uid The group ID. If this is specified then do not specify
the id or name parameters.

Text

Example Request

http://someco.pacifictimesheet.com/timesheet/rest/group/delete?name=Administrative+E
mployees 

Example Result

<?xml version="1.0" encoding="UTF-8" ?>
<response status="ok">
    <group/>
</response>

-o-
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Group.Get
Group.Get

Retrieves a particular group.

URL

/timesheet/rest/group/get

Parameters

Parameter Description Format

id The object ID, a unique, persistent identifier
generated by Pacific Timesheet. If this is specified
then do not specify the name or uid parameters.

Integer

name The group name. If this is specified then do not
specify the id or uid parameters.

Text

uid The group ID. If this is specified then do not specify
the id or name parameters.

Text

Example Request

http://someco.pacifictimesheet.com/timesheet/rest/group/get?name=Administrative+Empl
oyees 

Example Result

<?xml version="1.0" encoding="UTF-8" ?>
<response status="ok">
    <group id="3231" 
        name="Administrative Employees" 
        uid="G-1101" 
        description="Administrators etc." 
        status="Active" 
        userids="" 
        acls="" 
        notes=""/>
</response>

-o-

 



p139

© 2000-2007, Pacific Timesheet

Group.Update
Group.Update

Updates the properties of a particular group.

URL

/timesheet/rest/group/update

Parameters

To identify the group to be updated Pacific Timesheet looks for the following parameters in
the request:

Parameter Description Format

id The object ID, a unique, persistent identifier
generated by Pacific Timesheet.

Integer

name The group name. Text

uid The group ID. Text

If more than one of the above are specified then the group will be identified by using the
parameter in the order specified above: id, name then uid. 

In addition to the above parameters, all of the parameters defined in Group.Add are
supported.

Example Request

http://someco.pacifictimesheet.com/timesheet/rest/group/update?name=Administrative+E
mployees&status=Inactive 

Example Result

<?xml version="1.0" encoding="UTF-8" ?>
<response status="ok">
    <group id="3231"/>
</response>

-o-
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Session.Connect
Session.Connect

Logs in with the provided credentials and returns a session ID that can be used as a token.

URL

/timesheet/rest/session/connect

Parameters

auth-logi
n

The login name of an existing Pacific Timesheet user account. Require
d

auth-pass
word

The password for the user account. Require
d

Example Request

http://someco.pacifictimesheet.com/timesheet/rest/session/connect?auth-login=admin&au
th-password=12345 

Example Result

<?xml version="1.0" encoding="UTF-8" ?>
<response status="ok">
    <session id="87CBC30D72C7E93A9762617ED8B07F6E"/>
</response>

-o-
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Session.Disconnect
Session.Disconnect

Removes the active authentication session from the back-end, logging the user out.

URL

/timesheet/rest/session/disconnect

Parameters

No parameters are required. If cookies are not supported by your client you must append
the session ID (returned by the connect request) to the URL, for example:

http://someco.pacifictimesheet.com/timesheet/rest/session/disconnect;jsessionid=A5E8D1
5765A42A4EF82254A05E35D243

Example Request

http://someco.pacifictimesheet.com/timesheet/rest/session/disconnect 

Example Result

<?xml version="1.0" encoding="UTF-8" ?>
<response status="ok">
    <session/>
</response>

-o-
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Task.Add
Task.Add

Adds a new task.

Note: The term task may have been renamed in your system using the terminology
feature. For instance, in the System > General > Terminology page tasks may have been
renamed to activities. You still use the object name 'task', however, when using the REST
API. The name of the objects in the REST API never change.

URL

/timesheet/rest/task/add

Parameters

Field Description Format

name Task name. Always required when adding new tasks. Text (80
chars max)

uid Task ID. This field is not required, but if present and the value is
not blank then it must be unique for all tasks.

Text (80
chars max)

descriptio
n

A description of this task. Text (255
chars max)

status Task status. Possible value are:
Value Description
Active Employee can log into system.
Inactive Employee cannot log into system, and does not show

up on reports, etc. by default.

Text

acls The list of employees and groups given special permission on this
object. Multiple permissions have each value separated by a
carriage return (also called a "hard" carriage return in Excel,
entered using ALT+ENTER). Each value is of the form:

Object Name=Permission Level (Object Type)

Where Object Name is the name of the group or the login of the
employee, Permission Level is the permission level to give the
employee or group on this object, and Object Type is the whether
this is an Employee or Group that is being given permission. Here
is an example of a group and an employee assigned to an object:

GroupA=Timekeeper (Group)
jmeyers=Manager (Employee)

Note that the permission level and object type are optional. If the
permission level is not specified then it will be set to the
employee's default permission level. If the object type is not
specified the system will first check for a group with a matching
name, then look for an employee with a matching login name.
Only if you have group names and employee logins that might be
the same do you need to specify the object type.

Text

notes Notes about this task. Text (2000
chars max)
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Example Request

http://someco.pacifictimesheet.com/timesheet/rest/task/add?name=Administrative+Emplo
yees 

Example Result

<?xml version="1.0" encoding="UTF-8" ?>
<response status="ok">
    <task id="3231"/>
</response>

-o-
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Task.Delete
Task.Delete

Deletes a particular task.

Note: The term task may have been renamed in your system using the terminology
feature. For instance, in the System > General > Terminology page tasks may have been
renamed to activities. You still use the object name 'task', however, when using the REST
API. The name of the objects in the REST API never change.

URL

/timesheet/rest/task/delete

Parameters

Parameter Description Format

id The object ID, a unique, persistent identifier
generated by Pacific Timesheet. If this is specified
then do not specify the name or uid parameters.

Integer

name The task name. If this is specified then do not specify
the id or uid parameters.

Text

uid The task ID. If this is specified then do not specify
the id or name parameters.

Text

Example Request

http://someco.pacifictimesheet.com/timesheet/rest/task/delete?name=Administrative+Em
ployees 

Example Result

<?xml version="1.0" encoding="UTF-8" ?>
<response status="ok">
    <task/>
</response>

-o-

 



p145

© 2000-2007, Pacific Timesheet

Task.Get
Task.Get

Retrieves a particular task.

Note: The term task may have been renamed in your system using the terminology
feature. For instance, in the System > General > Terminology page tasks may have been
renamed to activities. You still use the object name 'task', however, when using the REST
API. The name of the objects in the REST API never change.

URL

/timesheet/rest/task/get

Parameters

Parameter Description Format

id The object ID, a unique, persistent identifier
generated by Pacific Timesheet. If this is specified
then do not specify the name or uid parameters.

Integer

name The task name. If this is specified then do not specify
the id or uid parameters.

Text

uid The task ID. If this is specified then do not specify
the id or name parameters.

Text

Example Request

http://someco.pacifictimesheet.com/timesheet/rest/task/get?name=Administrative+Emplo
yees 

Example Result

<?xml version="1.0" encoding="UTF-8" ?>
<response status="ok">
    <task id="3231" 
        name="Excelsior Projecct" 
        uid="P-1001" 
        description="25 nm process" 
        status="Active" 
        notes=""/>
</response>

-o-
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Task.Update
Task.Update

Updates the properties of a particular task.

Note: The term task may have been renamed in your system using the terminology
feature. For instance, in the System > General > Terminology page tasks may have been
renamed to activities. You still use the object name 'task', however, when using the REST
API. The name of the objects in the REST API never change.

URL

/timesheet/rest/task/update

Parameters

To identify the task to be updated Pacific Timesheet looks for the following parameters in
the request:

Parameter Description Format

id The object ID, a unique, persistent identifier
generated by Pacific Timesheet.

Integer

name The task name. Text

uid The task ID. Text

If more than one of the above are specified then the task will be identified by using the
parameter in the order specified above: id, name then uid. 

In addition to the above parameters, all of the parameters defined in Task.Add are
supported.

Example Request

http://someco.pacifictimesheet.com/timesheet/rest/task/update?name=Administrative+E
mployees&status=Inactive 

Example Result

<?xml version="1.0" encoding="UTF-8" ?>
<response status="ok">
    <task id="3231"/>
</response>

-o-
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TaskGroup.Add
TaskGroup.Add

Adds a new task group.

Note: The term task group may have been renamed in your system using the terminology
feature. For instance, in the System > General > Terminology page task groups may have
been renamed to phases. You still use the object name 'taskgroup', however, when using
the REST API. The name of the objects in the REST API never change.

URL

/timesheet/rest/taskgroup/add

Parameters

Field Description Format

name Task group name. Always required when adding new task groups. Text (80
chars max)

uid Task group ID. This field is not required, but if present and the
value is not blank then it must be unique for all task groups.

Text (80
chars max)

descriptio
n

A description of this task group. Text (255
chars max)

status Task group status. Possible value are:
Value Description
Active Employee can log into system.
Inactive Employee cannot log into system, and does not show

up on reports, etc. by default.

Text

acls The list of employees and groups given special permission on this
object. Multiple permissions have each value separated by a
carriage return (also called a "hard" carriage return in Excel,
entered using ALT+ENTER). Each value is of the form:

Object Name=Permission Level (Object Type)

Where Object Name is the name of the group or the login of the
employee, Permission Level is the permission level to give the
employee or group on this object, and Object Type is the whether
this is an Employee or Group that is being given permission. Here
is an example of a group and an employee assigned to an object:

GroupA=Timekeeper (Group)
jmeyers=Manager (Employee)

Note that the permission level and object type are optional. If the
permission level is not specified then it will be set to the
employee's default permission level. If the object type is not
specified the system will first check for a group with a matching
name, then look for an employee with a matching login name.
Only if you have group names and employee logins that might be
the same do you need to specify the object type.

Text

notes Notes about this task group. Text (2000
chars max)
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Example Request

http://someco.pacifictimesheet.com/timesheet/rest/taskgroup/add?name=Administrative+
Employees 

Example Result

<?xml version="1.0" encoding="UTF-8" ?>
<response status="ok">
    <taskgroup id="3231"/>
</response>

-o-
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TaskGroup.Delete
TaskGroup.Delete

Deletes a particular task group.

Note: The term task group may have been renamed in your system using the terminology
feature. For instance, in the System > General > Terminology page task groups may have
been renamed to phases. You still use the object name 'taskgroup', however, when using
the REST API. The name of the objects in the REST API never change.

URL

/timesheet/rest/taskgroup/delete

Parameters

Parameter Description Format

id The object ID, a unique, persistent identifier
generated by Pacific Timesheet. If this is specified
then do not specify the name or uid parameters.

Integer

name The task group name. If this is specified then do not
specify the id or uid parameters.

Text

uid The task group ID. If this is specified then do not
specify the id or name parameters.

Text

Example Request

http://someco.pacifictimesheet.com/timesheet/rest/taskgroup/delete?name=Administrativ
e+Employees 

Example Result

<?xml version="1.0" encoding="UTF-8" ?>
<response status="ok">
    <taskgroup/>
</response>

-o-
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TaskGroup.Get
TaskGroup.Get

Retrieves a particular task group.

Note: The term task group may have been renamed in your system using the terminology
feature. For instance, in the System > General > Terminology page task groups may have
been renamed to phases. You still use the object name 'taskgroup', however, when using
the REST API. The name of the objects in the REST API never change.

URL

/timesheet/rest/taskgroup/get

Parameters

Parameter Description Format

id The object ID, a unique, persistent identifier
generated by Pacific Timesheet. If this is specified
then do not specify the name or uid parameters.

Integer

name The task group name. If this is specified then do not
specify the id or uid parameters.

Text

uid The task group ID. If this is specified then do not
specify the id or name parameters.

Text

Example Request

http://someco.pacifictimesheet.com/timesheet/rest/taskgroup/get?name=Administrative+
Employees 

Example Result

<?xml version="1.0" encoding="UTF-8" ?>
<response status="ok">
    <taskgroup id="3231" 
        name="Excelsior Projecct" 
        uid="P-1001" 
        description="25 nm process" 
        status="Active" 
        notes=""/>
</response>

-o-
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TaskGroup.Update
TaskGroup.Update

Updates the properties of a particular task group.

Note: The term task group may have been renamed in your system using the terminology
feature. For instance, in the System > General > Terminology page task groups may have
been renamed to phases. You still use the object name 'taskgroup', however, when using
the REST API. The name of the objects in the REST API never change.

URL

/timesheet/rest/taskgroup/update

Parameters

To identify the task group to be updated Pacific Timesheet looks for the following
parameters in the request:

Parameter Description Format

id The object ID, a unique, persistent identifier
generated by Pacific Timesheet.

Integer

name The task group name. Text

uid The task group ID. Text

If more than one of the above are specified then the task group will be identified by using
the parameter in the order specified above: id, name then uid. 

In addition to the above parameters, all of the parameters defined in TaskGroup.Add are
supported.

Example Request

http://someco.pacifictimesheet.com/timesheet/rest/taskgroup/update?name=Administrativ
e+Employees&status=Inactive 

Example Result

<?xml version="1.0" encoding="UTF-8" ?>
<response status="ok">
    <taskgroup id="3231"/>
</response>

-o-
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TimeEntry.Add
TimeEntry.Add

Adds a new time entry. If a time entry already exists for the same employee login (userid)
and start date it will update the existing time entry.

URL

/timesheet/rest/timeentry/add

Parameters

Field Description Format

userid Employee login name. This is required for new time
entries.

Text

start Time entry start date and time. This is required for
new time entries.

Date-Time

finish Time entry finish date and time. This or hours is
required for new time entries.

Date-Time

hours Time entry hours. This or finish is required. Number

type Time entry type, either Work or Leave. Text

workhours Work hours. Number

leavehours Leave hours. Number

paycodeid Pay code name. Text

groupid Reporting group name. Text

customerid Customer name. Text

projectgroupid Project group name. Text

projectid Project name. Text

taskgroupid Task group name. Text

taskid Task name. Text

billrate Bill rate for this time entry. Number

billamount Bill amount for this time entry, which is Bill Rate x
Hours.

Number

payrate Pay rate for this time entry. Number

payamount Pay amount for this time entry, which is Pay Rate x
Hours.

Number

notes Time entry notes. Text (2000 chars
max)

locked Indicates whether this time entry has been
submitted (locked). Possible values are Yes or No.

Text

lockdate The date this time entry was submitted. Date

lockerid Who submitted this time entry. Text

apprv1 Indicates whether this time entry has been
approved. Possible values are Yes or No.

Text

apprv1date The date this time entry was approved. Date

apprv1id Who approved this time entry. Approver
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rejected Indicates whether this time entry has been rejected
by an approver. Possible values are Yes or No.

Text

rejectdate The date this time entry was rejected. Date

rejecterid Who rejected this time entry. Text

Example Request

http://someco.pacifictimesheet.com/timesheet/rest/timeentry/add?userid=admin&start=1
1/27/2007+9:00AM&hours=8.0

Example Result

<?xml version="1.0" encoding="UTF-8" ?>
<response status="ok">
    <timeentry id="43371"/>
</response>

-o-
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TimeEntry.Delete
TimeEntry.Delete

Deletes a particular time entry. The time entry can be identified by either the object ID, or a
combination of the employee login (userid) and start date of the time entry.

URL

/timesheet/rest/timeentry/delete

Parameters

Parameter Description Format

id The object ID, a unique, persistent identifier
generated by Pacific Timesheet. If this is specified
then do not specify the userid or start parameters.

Integer

userid The employee login name. If this is specified then
also specify the start parameter, but do not specify
the id parameter.

Text

start The start date and time. If this is specified then also
specify the userid parameter, but do not specify the
id parameter.

Date

Example Request

http://someco.pacifictimesheet.com/timesheet/rest/timeentry/delete?userid=admin&start
=11/27/2007+9:00AM

Example Result

<?xml version="1.0" encoding="UTF-8" ?>
<response status="ok">
    <timeentry/>
</response>

-o-
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TimeEntry.Get
TimeEntry.Get

Retrieves a particular time entry. The time entry can be identified by either the object ID, or
a combination of the employee login (userid) and start date of the time entry.

URL

/timesheet/rest/timeentry/get

Parameters

Parameter Description Format

id The object ID, a unique, persistent identifier
generated by Pacific Timesheet. If this is specified
then do not specify the userid or start parameters.

Integer

userid The employee login name. If this is specified then
also specify the start parameter, but do not specify
the id parameter.

Text

start The start date and time. If this is specified then also
specify the userid parameter, but do not specify the
id parameter.

Date

Example Request

http://someco.pacifictimesheet.com/timesheet/rest/timeentry/get?userid=admin&start=11
/27/2007+9:00AM

Example Result
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<?xml version="1.0" encoding="UTF-8" ?>
<response status="ok">
    <timeentry id="43371" 
        userid="admin" 
        start="11/27/2007 9:00AM" 
        finish="11/27/2007 5:00PM" 
        hours="8.00" 
        type="Work" 
        workhours="8.00" 
        leavehours="0.00" 
        paycodeid="" 
        groupid="Administrative Employees" 
        customerid="Progressive Insurance" 
        projectgroupid="" 
        projectid="Prospect Project" 
        taskgroupid="" 
        taskid="Planning" 
        billrate="150.00" 
        billamount="1200.00" 
        payrate="0.00" 
        payamount="0.00" 
        notes="" 
        locked="Yes" 
        lockdate="12/4/2007 6:57AM" 
        lockerid="admin" 
        apprv1="No" 
        apprv1id="" 
        rejected="No"
        rejecterid=""/>
</response>

-o-
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TimeEntry.Punch
TimeEntry.Punch

Punches the employee in or out. The employee is specified by the userid parameter, which
can be either their login name or employee ID. The punch time and date is specified by the
timestamp parameter. The API will automatically determine if it is an "in" or "out" punch
based on whether the employee is currently in or out.

URL

/timesheet/rest/timeentry/punch

Parameters

To identify the time entry to be updated Pacific Timesheet looks for the following
parameters in the request:

Parameter Description Format

userid The employee login name or employee ID. Text

timestamp The punch date and time. It should be in the time
zone of the account used to authorize the REST
request, for example the admin account. The format
is the date and time format of the account used to
authorize the request (for example mm-dd-yyy
hh:mm), or in ISO format (yyyy-mm-dd hh:mm).

Date

In addition to the above parameters, all of the parameters defined in TimeEntry.Add are
supported.

Results

If successful, a timeentry record will be returned with the following XML attributes:

Parameter Description Format

id The unique ID of the affected time entry. Integer

in Indicates whether the employee is punched in as a
result of this punch request, either "Yes" or "No".

String

Example Request

http://someco.pacifictimesheet.com/timesheet/rest/timeentry/punch?userid=admin&times
tamp=2008-07-15+09:00

Example Result

<?xml version="1.0" encoding="UTF-8" ?>
<response status="ok">
    <timeentry id="43371" status="in"/>
</response>

-o-
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TimeEntry.Update
TimeEntry.Update

Updates the properties of a time entry. The time entry can be identified by either the object
ID, or a combination of the employee login (userid) and start date of the time entry. If the
time entry is identified by the userid and start, and no time entry already exists, a new one
will be added.

URL

/timesheet/rest/timeentry/update

Parameters

To identify the time entry to be updated Pacific Timesheet looks for the following
parameters in the request:

Parameter Description Format

id The object ID, a unique, persistent identifier
generated by Pacific Timesheet. If this is specified
then do not specify the userid or start parameters.

Integer

userid The employee login name. If this is specified then
also specify the start parameter, but do not specify
the id parameter.

Text

start The start date and time. If this is specified then also
specify the userid parameter, but do not specify the
id parameter.

Date

In addition to the above parameters, all of the parameters defined in TimeEntry.Add are
supported.

Example Request

http://someco.pacifictimesheet.com/timesheet/rest/timeentry/update?userid=admin&start
=11/27/2007+9:00AM&hours=7.5

Example Result

<?xml version="1.0" encoding="UTF-8" ?>
<response status="ok">
    <timeentry id="43371"/>
</response>

-o-
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Project.Add
Project.Add

Adds a new project.

Note: The term project may have been renamed in your system using the terminology
feature. For instance, in the System > General > Terminology page projects may have
been renamed to jobs. You still use the object name 'project', however, when using the
REST API. The name of the objects in the REST API never change.

URL

/timesheet/rest/project/add

Parameters

Field Description Format

name Project name. Always required when adding new projects. Text (80
chars max)

uid Project ID. This field is not required, but if present and the value
is not blank then it must be unique for all projects.

Text (80
chars max)

descriptio
n

A description of this project. Text (255
chars max)

status Project status. Possible value are:
Value Description
Active Employee can log into system.
Inactive Employee cannot log into system, and does not show

up on reports, etc. by default.

Text

acls The list of employees and groups given special permission on this
object. Multiple permissions have each value separated by a
carriage return (also called a "hard" carriage return in Excel,
entered using ALT+ENTER). Each value is of the form:

Object Name=Permission Level (Object Type)

Where Object Name is the name of the group or the login of the
employee, Permission Level is the permission level to give the
employee or group on this object, and Object Type is the whether
this is an Employee or Group that is being given permission. Here
is an example of a group and an employee assigned to an object:

GroupA=Timekeeper (Group)
jmeyers=Manager (Employee)

Note that the permission level and object type are optional. If the
permission level is not specified then it will be set to the
employee's default permission level. If the object type is not
specified the system will first check for a group with a matching
name, then look for an employee with a matching login name.
Only if you have group names and employee logins that might be
the same do you need to specify the object type.

Text

notes Notes about this project. Text (2000
chars max)
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Example Request

http://someco.pacifictimesheet.com/timesheet/rest/project/add?name=Administrative+Em
ployees 

Example Result

<?xml version="1.0" encoding="UTF-8" ?>
<response status="ok">
    <project id="3231"/>
</response>

-o-
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Project.Delete
Project.Delete

Deletes a particular project.

Note: The term project may have been renamed in your system using the terminology
feature. For instance, in the System > General > Terminology page projects may have
been renamed to jobs. You still use the object name 'project', however, when using the
REST API. The name of the objects in the REST API never change.

URL

/timesheet/rest/project/delete

Parameters

Parameter Description Format

id The object ID, a unique, persistent identifier
generated by Pacific Timesheet. If this is specified
then do not specify the name or uid parameters.

Integer

name The project name. If this is specified then do not
specify the id or uid parameters.

Text

uid The project ID. If this is specified then do not specify
the id or name parameters.

Text

Example Request

http://someco.pacifictimesheet.com/timesheet/rest/project/delete?name=Administrative+
Employees 

Example Result

<?xml version="1.0" encoding="UTF-8" ?>
<response status="ok">
    <project/>
</response>

-o-
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Project.Get
Project.Get

Retrieves a particular project.

Note: The term project may have been renamed in your system using the terminology
feature. For instance, in the System > General > Terminology page projects may have
been renamed to jobs. You still use the object name 'project', however, when using the
REST API. The name of the objects in the REST API never change.

URL

/timesheet/rest/project/get

Parameters

Parameter Description Format

id The object ID, a unique, persistent identifier
generated by Pacific Timesheet. If this is specified
then do not specify the name or uid parameters.

Integer

name The project name. If this is specified then do not
specify the id or uid parameters.

Text

uid The project ID. If this is specified then do not specify
the id or name parameters.

Text

Example Request

http://someco.pacifictimesheet.com/timesheet/rest/project/get?name=Administrative+Em
ployees 

Example Result

<?xml version="1.0" encoding="UTF-8" ?>
<response status="ok">
    <project id="3231" 
        name="Excelsior Projecct" 
        uid="P-1001" 
        description="25 nm process" 
        status="Active" 
        notes=""/>
</response>

-o-
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Project.Update
Project.Update

Updates the properties of a particular project.

Note: The term project may have been renamed in your system using the terminology
feature. For instance, in the System > General > Terminology page projects may have
been renamed to jobs. You still use the object name 'project', however, when using the
REST API. The name of the objects in the REST API never change.

URL

/timesheet/rest/project/update

Parameters

To identify the project to be updated Pacific Timesheet looks for the following parameters in
the request:

Parameter Description Format

id The object ID, a unique, persistent identifier
generated by Pacific Timesheet.

Integer

name The project name. Text

uid The project ID. Text

If more than one of the above are specified then the project will be identified by using the
parameter in the order specified above: id, name then uid. 

In addition to the above parameters, all of the parameters defined in Project.Add are
supported.

Example Request

http://someco.pacifictimesheet.com/timesheet/rest/project/update?name=Administrative+
Employees&status=Inactive 

Example Result

<?xml version="1.0" encoding="UTF-8" ?>
<response status="ok">
    <project id="3231"/>
</response>

-o-
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ProjectGroup.Add
ProjectGroup.Add

Adds a new project group.

Note: The term project group may have been renamed in your system using the
terminology feature. For instance, in the System > General > Terminology page project
groups may have been renamed to portfolios. You still use the object name 'projectgroup',
however, when using the REST API. The name of the objects in the REST API never
change.

URL

/timesheet/rest/projectgroup/add

Parameters

Field Description Format

name Project group name. Always required when adding new project
groups.

Text (80
chars max)

uid Project group ID. This field is not required, but if present and the
value is not blank then it must be unique for all project groups.

Text (80
chars max)

descriptio
n

A description of this project group. Text (255
chars max)

status Project group status. Possible value are:
Value Description
Active Employee can log into system.
Inactive Employee cannot log into system, and does not show

up on reports, etc. by default.

Text

acls The list of employees and groups given special permission on this
object. Multiple permissions have each value separated by a
carriage return (also called a "hard" carriage return in Excel,
entered using ALT+ENTER). Each value is of the form:

Object Name=Permission Level (Object Type)

Where Object Name is the name of the group or the login of the
employee, Permission Level is the permission level to give the
employee or group on this object, and Object Type is the whether
this is an Employee or Group that is being given permission. Here
is an example of a group and an employee assigned to an object:

GroupA=Timekeeper (Group)
jmeyers=Manager (Employee)

Note that the permission level and object type are optional. If the
permission level is not specified then it will be set to the
employee's default permission level. If the object type is not
specified the system will first check for a group with a matching
name, then look for an employee with a matching login name.
Only if you have group names and employee logins that might be
the same do you need to specify the object type.

Text
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notes Notes about this project group. Text (2000
chars max)

Example Request

http://someco.pacifictimesheet.com/timesheet/rest/projectgroup/add?name=Administrativ
e+Employees 

Example Result

<?xml version="1.0" encoding="UTF-8" ?>
<response status="ok">
    <projectgroup id="3231"/>
</response>

-o-
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ProjectGroup.Delete
ProjectGroup.Delete

Deletes a particular project group.

Note: The term project group may have been renamed in your system using the
terminology feature. For instance, in the System > General > Terminology page project
groups may have been renamed to portfolios. You still use the object name 'projectgroup',
however, when using the REST API. The name of the objects in the REST API never
change.

URL

/timesheet/rest/projectgroup/delete

Parameters

Parameter Description Format

id The object ID, a unique, persistent identifier
generated by Pacific Timesheet. If this is specified
then do not specify the name or uid parameters.

Integer

name The project group name. If this is specified then do
not specify the id or uid parameters.

Text

uid The project group ID. If this is specified then do not
specify the id or name parameters.

Text

Example Request

http://someco.pacifictimesheet.com/timesheet/rest/projectgroup/delete?name=Administra
tive+Employees 

Example Result

<?xml version="1.0" encoding="UTF-8" ?>
<response status="ok">
    <projectgroup/>
</response>

-o-
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ProjectGroup.Get
ProjectGroup.Get

Retrieves a particular project group.

Note: The term project group may have been renamed in your system using the
terminology feature. For instance, in the System > General > Terminology page project
groups may have been renamed to portfolios. You still use the object name 'projectgroup',
however, when using the REST API. The name of the objects in the REST API never
change.

URL

/timesheet/rest/projectgroup/get

Parameters

Parameter Description Format

id The object ID, a unique, persistent identifier
generated by Pacific Timesheet. If this is specified
then do not specify the name or uid parameters.

Integer

name The project group name. If this is specified then do
not specify the id or uid parameters.

Text

uid The project group ID. If this is specified then do not
specify the id or name parameters.

Text

Example Request

http://someco.pacifictimesheet.com/timesheet/rest/projectgroup/get?name=Administrativ
e+Employees 

Example Result

<?xml version="1.0" encoding="UTF-8" ?>
<response status="ok">
    <projectgroup id="3231" 
        name="Excelsior Projecct" 
        uid="P-1001" 
        description="25 nm process" 
        status="Active" 
        notes=""/>
</response>

-o-
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ProjectGroup.Update
ProjectGroup.Update

Updates the properties of a particular project group.

Note: The term project group may have been renamed in your system using the
terminology feature. For instance, in the System > General > Terminology page project
groups may have been renamed to portfolios. You still use the object name 'projectgroup',
however, when using the REST API. The name of the objects in the REST API never
change.

URL

/timesheet/rest/projectgroup/update

Parameters

To identify the project group to be updated Pacific Timesheet looks for the following
parameters in the request:

Parameter Description Format

id The object ID, a unique, persistent identifier
generated by Pacific Timesheet.

Integer

name The project group name. Text

uid The project group ID. Text

If more than one of the above are specified then the project group will be identified by using
the parameter in the order specified above: id, name then uid. 

In addition to the above parameters, all of the parameters defined in ProjectGroup.Add are
supported.

Example Request

http://someco.pacifictimesheet.com/timesheet/rest/projectgroup/update?name=Administr
ative+Employees&status=Inactive 

Example Result

<?xml version="1.0" encoding="UTF-8" ?>
<response status="ok">
    <projectgroup id="3231"/>
</response>

-o-
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User.Add
User.Add

Adds a new user (employee).

URL

/timesheet/rest/user/add

Parameters

Parameter Description Form
at

login Employee login name. Always required when adding new
employees.

Text
(80
chars
max)

password Employee password. Setting an employee's password creates an
expired password - the employee will be asked to enter a new one
the next time they log in.

Text
(40
chars
max)

firstname First name. Text
(80
chars
max)

lastname Last name. Always required when adding new employees. Text
(80
chars
max)

uid Employee ID. This field is not required, but if present and the
value is not blank then it must be unique for all employees.

Text
(80
chars
max)

status Employee status. Possible value are:
Value Description
Active Employee can log into system.
Inactive Employee cannot log into system, and does not show

up on reports, etc. by default.
Locked Employee cannot log into system, but shows up on

reports, etc. by default. An employee can become
locked due to too many unsuccessful login attempts.

Text

roleid The default role (permission level), for example Employee. Text

type The type of employee. Text

policyid The policy for this employee. Text

jobtitle Job title. Text
(80
chars
max)

groupid The name of the primary or reporting group. Text

firstday The first day of employment. Date

lastday The last day of employment. Date
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scheduledhours The number of hours the employee is scheduled to work each
week.

Num
ber

email Email address. Text
(80
chars
max)

phone Phone number. Text
(40
chars
max)

mobile Mobile phone number. Text
(40
chars
max)

fax Fax number. Text
(40
chars
max)

timesheetid The timesheet template for this employee. Text

timesheetcarryf
orward

This controls whether rows and hours are carried forward from
the previous timesheet to new timesheets. Possible values are:
Value Description
None None (or a blank value) indicates no

rows or hours will be carried forward.
Rows Timesheet rows will be carried forward

from previous timesheet.
Rows and Hours Timesheet rows and hours will be

carried forward from previous
timesheet.

Text

locale Locale. The locale determines how dates and numbers are
formatted. Locale are specified using ISO codes, and possible
values are defined in the Locale Codes appendix.

Text
(5
chars
max)

timezone Time zone. Time zones are specified using Olson IDs, and possible
values are defined in the Time Zone Codes appendix.

Text
(40
chars
max)

billratex The default bill rate. This can be a named rate, or a custom
numeric value.

Text
or
Num
ber

payratex The default pay rate. This can be a named rate, or a custom
numeric value.

Text
or
Num
ber

groupids The list of groups this employee is a member of. If a user belongs
to multiple groups then each group is separated by a carriage
return. If formatting an import file using Excel you can enter
multiple lines in a cell using ALT+ENTER (also called a "hard"
carriage return). 

Text
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notes Notes about this employee. Text
(200
0
chars
max)

apprv1id This login name of the primary timesheet approver for the
employee.

Text

apprv1bid This login name of the backup timesheet approver for the
employee.

Text

Example Request

http://someco.pacifictimesheet.com/timesheet/rest/user/add?login=kwagner&password=1
2345&firstname=Kim&lastname=Wagner 

Example Result

<?xml version="1.0" encoding="UTF-8" ?>
<response status="ok">
    <user id="2256"/>
</response>

-o-
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User.Delete
User.Delete

Deletes a particular user (employee).

URL

/timesheet/rest/user/delete

Parameters

Parameter Description Format

id The object ID, a unique, persistent identifier
generated by Pacific Timesheet. If this is specified
then do not specify the login or uid parameters.

Integer

login The employee login name. If this is specified then do
not specify the id or uid parameters.

Text

uid The employee ID. If this is specified then do not
specify the id or login parameters.

Text

Example Request

http://someco.pacifictimesheet.com/timesheet/rest/user/delete?login=kwagner 

Example Result

<?xml version="1.0" encoding="UTF-8" ?>
<response status="ok">
    <user/>
</response>

-o-
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User.Get
User.Get

Retrieves a particular user (employee).

URL

/timesheet/rest/user/get

Parameters

Parameter Description Format

id The object ID, a unique, persistent identifier
generated by Pacific Timesheet. If this is specified
then do not specify the login or uid parameters.

Integer

login The employee login name. If this is specified then do
not specify the id or uid parameters.

Text

uid The employee ID. If this is specified then do not
specify the id or login parameters.

Text

Example Request

http://someco.pacifictimesheet.com/timesheet/rest/user/get?login=admin 

Example Result

<?xml version="1.0" encoding="UTF-8" ?>
<response status="ok">
    <user id="1" 
        login="admin" 
        firstname="M." 
        lastname="Admin" 
        uid="A100" 
        status="Active" 
        roleid="Administrator" 
        type="Exempt" 
        policyid="Standard Policy" 
        jobtitle="Application Administrator" 
        groupid="Administrative Employees" 
        firstday="1/1/2000" 
        scheduledhours="0.00" 
        email="admin@someco.com" 
        phone="503-555-1212" 
        mobile="" 
        fax="" 
        timesheetid="Project Timesheet" 
        timesheetcarryforward="Rows and Hours" 
        locale="en_US" 
        timezone="America/Los_Angeles" 
        groupids="Administrative Employees" 
        notes="" 
        apprv1id="" 
        apprv1bid=""
        in="false"/>
</response>
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User.Update
User.Update

Updates the properties of a particular user (employee).

URL

/timesheet/rest/user/update

Parameters

To identify the user to be updated Pacific Timesheet looks for the following parameters in
the request:

Parameter Description Format

id The object ID, a unique, persistent identifier
generated by Pacific Timesheet.

Integer

login The employee login name. Text

uid The employee ID. Text

If more than one of the above are specified then the user will be identified by using the
parameter in the order specified above: id, login, then uid. 

In addition to the above parameters, all of the parameters defined in User.Add are
supported.

Example Request

http://someco.pacifictimesheet.com/timesheet/rest/user/update?login=kwagner&email=kw
agner@someco.com 

Example Result

<?xml version="1.0" encoding="UTF-8" ?>
<response status="ok">
    <user id="2256"/>
</response>

-o-
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FAQ - Frequently Asked Questions
Administrative Topics

Q: How do I allow managers to edit their worker's timesheets? 

A: By default a manager cannot edit other employee timesheets, even if they are an
approver for them. To allow a manager to edit other employee timesheets do the following: 

1. Make sure the manager, let's call her "Sarah Manager", has either the Manager
permission level, or a permission level that allows timesheet editing. You can check an
employee's permission level from the Employees tab. You can check whether a
permission level has the timesheet editing permission from the System > Security
page. 

2. Go to the Employees > Groups page and create a new group. 
3. Assign all of the employees whose timesheets Sarah Manager needs to edit to this

group. 
4. Edit the permissions for this group and add Sarah Manager to the list as a Manager (or

any other appropriate permission level that allows timesheet editing).

When Sarah Manager logs into the application she should see a Timesheets tab, and should
be able to list and edit timesheets for all the employees in the new group.

-o-
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Appendix
 Locale Codes
 Time Zone Codes
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Locale Codes
ISO locale (language_country) codes:

Value Description
sq_AL Albanian (Albania)
ar_DZ Arabic (Algeria)
ar_BH Arabic (Bahrain)
ar_EG Arabic (Egypt)
ar_IQ Arabic (Iraq)
ar_JO Arabic (Jordan)
ar_KW Arabic (Kuwait)
ar_LB Arabic (Lebanon)
ar_LY Arabic (Libya)
ar_MA Arabic (Morocco)
ar_OM Arabic (Oman)
ar_QA Arabic (Qatar)
ar_SA Arabic (Saudi Arabia)
ar_SD Arabic (Sudan)
ar_SY Arabic (Syria)
ar_TN Arabic (Tunisia)
ar_AE Arabic (United Arab Emirates)
ar_YE Arabic (Yemen)
be_BY Belarusian (Belarus)
bg_BG Bulgarian (Bulgaria)
ca_ES Catalan (Spain)
zh_CN Chinese (China)
zh_HK Chinese (Hong Kong)
zh_TW Chinese (Taiwan)
hr_HR Croatian (Croatia)
cs_CZ Czech (Czech Republic)
da_DK Danish (Denmark)
nl_BE Dutch (Belgium)
nl_NL Dutch (Netherlands)
en_AU English (Australia)
en_CA English (Canada)
en_IN English (India)
en_IE English (Ireland)
en_NZ English (New Zealand)
en_ZA English (South Africa)
en_GB English (United Kingdom)
en_US English (United States)
et_EE Estonian (Estonia)
fi_FI Finnish (Finland)
fr_BE French (Belgium)
fr_CA French (Canada)
fr_FR French (France)
fr_LU French (Luxembourg)
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fr_CH French (Switzerland)
de_AT German (Austria)
de_DE German (Germany)
de_LU German (Luxembourg)
de_CH German (Switzerland)
el_GR Greek (Greece)
iw_IL Hebrew (Israel)
hi_IN Hindi (India)
hu_HU Hungarian (Hungary)
is_IS Icelandic (Iceland)
it_IT Italian (Italy)
it_CH Italian (Switzerland)
ja_JP Japanese (Japan)
ko_KR Korean (South Korea)
lv_LV Latvian (Latvia)
lt_LT Lithuanian (Lithuania)
mk_MK Macedonian (Macedonia)
no_NO Norwegian (Norway)
pl_PL Polish (Poland)
pt_BR Portuguese (Brazil)
pt_PT Portuguese (Portugal)
ro_RO Romanian (Romania)
ru_RU Russian (Russia)
sk_SK Slovak (Slovakia)
sl_SI Slovenian (Slovenia)
es_AR Spanish (Argentina)
es_BO Spanish (Bolivia)
es_CL Spanish (Chile)
es_CO Spanish (Colombia)
es_CR Spanish (Costa Rica)
es_DO Spanish (Dominican Republic)
es_EC Spanish (Ecuador)
es_SV Spanish (El Salvador)
es_GT Spanish (Guatemala)
es_HN Spanish (Honduras)
es_MX Spanish (Mexico)
es_NI Spanish (Nicaragua)
es_PA Spanish (Panama)
es_PY Spanish (Paraguay)
es_PE Spanish (Peru)
es_PR Spanish (Puerto Rico)
es_ES Spanish (Spain)
es_UY Spanish (Uruguay)
es_VE Spanish (Venezuela)
sv_SE Swedish (Sweden)
th_TH Thai (Thailand)
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th_TH Thai (Thailand,TH)
tr_TR Turkish (Turkey)
uk_UA Ukrainian (Ukraine)
vi_VN Vietnamese (Vietnam)

-o-
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Time Zone Codes
Standard (Olson ID) time zones codes:

Value Description
MIT (GMT-11:00) International Date Line W.
Pacific/Apia (GMT-11:00) Midway Island, Samoa
Pacific/Honolulu (GMT-10:00) Hawaii
America/Anchorage (GMT-09:00) Alaska
America/Los_Angeles (GMT-08:00) Pacific Time
America/Denver (GMT-07:00) Mountain Time
America/Phoenix (GMT-07:00) Arizona
America/Chicago (GMT-06:00) Central Time
America/Costa_Rica (GMT-06:00) Central America
America/Mexico_City (GMT-06:00) Mexico City
America/Tegucigalpa (GMT-06:00) La Paz
America/Winnipeg (GMT-06:00) Saskatchewan
America/Bogota (GMT-05:00) Bogota
America/Indianapolis (GMT-05:00) Indiana (East)
America/Montreal (GMT-05:00) Atlantic Time (Canada)
America/New_York (GMT-05:00) Eastern Time
America/Caracas (GMT-04:00) Caracas, La Paz
America/Santiago (GMT-04:00) Santiago
America/Thule (GMT-04:00) Greenland
America/St_Johns (GMT-03:30) Newfoundland
America/Buenos_Aires (GMT-03:00) Buenos Aires
America/Sao_Paulo (GMT-03:00) Brasilia
Atlantic/South_Georgia (GMT-02:00) Mid-Atlantic
Atlantic/Azores (GMT-01:00) Azores
Atlantic/Cape_Verde (GMT-01:00) Cape Verde Is.
Africa/Casablanca (GMT+00:00) Casablanca, Monrovia
Europe/Dublin (GMT+00:00) Greenwich Mean Time
Africa/Lagos (GMT+01:00) West Central Africa
Europe/Amsterdam (GMT+01:00) Amsterdam, Rome
Europe/Belgrade (GMT+01:00) Belgrade, Prague
Europe/Brussels (GMT+01:00) Brussels, Madrid
Europe/Warsaw (GMT+01:00) Sarajevo, Warsaw
Africa/Cairo (GMT+02:00) Cairo
Africa/Harare (GMT+02:00) Harare, Pretoria
Asia/Jerusalem (GMT+02:00) Jerusalem
Europe/Athens (GMT+02:00) Athens, Istanbul
Europe/Bucharest (GMT+02:00) Bucharest
Europe/Helsinki (GMT+02:00) Helsinki
Africa/Nairobi (GMT+03:00) Nairobi
Asia/Baghdad (GMT+03:00) Baghdad
Asia/Kuwait (GMT+03:00) Kuwait, Riyadh
Europe/Moscow (GMT+03:00) Moscow, St. Petersburg
Asia/Tehran (GMT+03:30) Tehran
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Asia/Baku (GMT+04:00) Baku, Tbilisi
Asia/Dubai (GMT+04:00) Abu Dhabi
Asia/Kabul (GMT+04:30) Kabul
Asia/Karachi (GMT+05:00) Islamabad, Karachi
Asia/Yekaterinburg (GMT+05:00) Ekaterinburg
Asia/Calcutta (GMT+05:30) Chennai, Kolkata
Asia/Katmandu (GMT+05:45) Kathmandu
Asia/Almaty (GMT+06:00) Almaty
Asia/Colombo (GMT+06:00) Sri Jayawardenepura
Asia/Dhaka (GMT+06:00) Astana, Dhaka
Asia/Rangoon (GMT+06:30) Rangoon
Asia/Bangkok (GMT+07:00) Bangkok, Hanoi
Asia/Krasnoyarsk (GMT+07:00) Krasnoyarsk
Asia/Hong_Kong (GMT+08:00) Beijing, Hong Kong
Asia/Irkutsk (GMT+08:00) Irkutsk
Asia/Kuala_Lumpur (GMT+08:00) Kuala Lumpur, Singapore
Asia/Taipei (GMT+08:00) Taipei
Australia/Perth (GMT+08:00) Perth
Asia/Seoul (GMT+09:00) Seoul
Asia/Tokyo (GMT+09:00) Osaka, Tokyo
Asia/Yakutsk (GMT+09:00) Yakutsk
Australia/Adelaide (GMT+09:30) Adelaide
Asia/Vladivostok (GMT+10:00) Vladivostok
Australia/Brisbane (GMT+10:00) Brisbane
Australia/Hobart (GMT+10:00) Hobart
Australia/Sydney (GMT+10:00) Canberra, Sydney
Pacific/Guam (GMT+10:00) Guam
Asia/Magadan (GMT+11:00) Magadan, Solomon Is.
Pacific/Auckland (GMT+12:00) Auckland
Pacific/Fiji (GMT+12:00) Fiji, Kamchatka
Pacific/Tongatapu (GMT+13:00) Nuku'alofa
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